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Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©October 2011

Trademarks

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
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Preface
R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Direc-
tive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

CE Marking
This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark
is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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Preface
FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.

And

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.
III



Preface
FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This 
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator 
and your body.

EuP Off Mode Power Consumption Statement:
The figures below note the power consumption of this computer in compliance with European Commission (EC)
regulations on power consumption in off mode:

• Off Mode < 1W


Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
IV



Preface
IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (Full Range AC/DC Adapter - AC Input 100 - 

240V, 50 - 60Hz DC Output 19V, 11.57A (220W) minimum).

This Computer’s Optical Device is a Laser Class 1 Product
V



Preface
Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place where 
foreign matter or moisture may 

affect the system.

Don’t use or store the computer 
in a humid environment.

Do not place the computer on 
any surface that will block the 

Vents/Fan Intakes.
VI



Preface
3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power until 
you properly shut down all pro-
grams.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
VII
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a steady, 

uninterrupted power supply. If you are unsure of your local power specifications, consult 
your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong 
is an important safety feature; do not defeat its purpose. If you do not have access to a 
compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by 
its wire.

• Make sure the socket and any extension cord(s) you use can support the total current load 
of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power sup-
plies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.


Power Safety 

Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
VIII
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

• Polymer batteries may experience a slight expansion or swelling, however this is part of the battery’s safety mecha-
nism and is not a cause for concern.

• Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
IX
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• If you do not use the battery for an extended period, then remove the battery from the computer for storage.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.


Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
X
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.


Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your “papers” are handy.


Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer
from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
XII
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
XIII
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a 
footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles when 

you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent and 

short breaks are better than fewer and longer breaks.
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Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.

LCD Electro-Plated Logos
Note that in computers featuring a raised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your service center.
XV
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Quick Start Guide 1
Chapter 1: Quick Start Guide

Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, Multi-In-1 card reader), Game Keys, TouchPad & Mouse, Audio Features & 
Printer.

• Chapter 3 The computer’s power management options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s RAID, PC Camera, Wireless LAN, Fingerprint and Bluetooth 

& WLAN Combo modules (some of which may be optional depending on your purchase configu-
ration).

• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the NVIDIA Video driver controls.
• Appendix C The computer’s specification.
Overview 1 - 1
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer”
on page 6 - 1 in the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in this Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the
 symbol. Also please note the safety and handling instructions as indicated in the Preface.


Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features. 
1 - 2 Overview
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Not Included
Operating Systems (e.g. Windows 7) and applications (e.g. word processing, spreadsheet and database programs)
have their own manuals, so please consult the appropriate manuals.


Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component
e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4
- 3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your
system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers
& Utilities” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to com-
municate with external devices, connect to the internet etc.
Overview 1 - 3
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the Windows 7 (with Service Pack 1 in-
stalled) operating system is supported.

Note: In order to run Windows 7 (SP1) without limitations or decreased performance, your computer requires a
minimum 1GB of system memory (RAM).

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the Windows OS (see “Setting
Up SATA RAID or AHCI Mode” on page 7 - 2).
1 - 4 Overview
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System Startup
1. Remove all packing materials, and place the computer on a stable surface.
2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
3. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter.
4. Use one hand to raise the lid/LCD to a comfortable viewing angle (it is preferable not to exceed 135 degrees); use 

the other hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the 
computer by the lid/LCD).

5. Raise the lid/LCD to a comfortable viewing angle, and press the power button.

Figure 1 - 1 - Computer with AC/DC Adapter Plugged-In/Opening the Lid/LCD


Shutdown

Note that you should always shut your computer down by choosing the Shut Down command from the Start menu in Win-
dows 7. This will help prevent hard disk or system problems.

135
System Startup 1 - 5
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System Map: LCD Panel Open & Top ViewFigure 1 - 2 
LCD Panel Open 

& Top View

1. Optional Built-In PC 
Camera

2. Built-in Microphone
3. LCD
4. LED Status Indicators
5. Touch Sensor 

Instant Keys
6. 8 * Gaming Keys
7. Keyboard
8. TouchPad and 

Buttons
9. Fingerprint Reader 

Module (optional)
10. LED Power Indicators
11. LCD Panel Color 

LED

See Appendix A for a more
detailed description of the
ports & jacks etc.

21

7

8

9

5

6

4

10
11


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable elec-
tronic transmission devices (e.g.
WLAN or Bluetooth) aboard air-
craft is usually prohibited. Make
sure any wireless modules are
OFF if you are using the comput-
er aboard aircraft.

Use the appropriate function key
combination/Touch Sensor Key
to toggle power to any wireless
modules, and check the indica-
tors to see if any modules are
powered on or not (see Table 1
- 2, on page 1 - 9).

3

1 - 6 System Map: LCD Panel Open & Top View
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LED Indicators
The two sets of LED indicators (LED Status Indicators and LED Power Indicators) display helpful informa-
tion about the current status of the computer.

Table 1 - 1 - LED Status Indicators

*Note: The powered USB 2.0 port (see Figure 1 - 7 on page 1 - 14) may be toggled on /off by means of the Fn + Power
Button key combination. When the powered USB port is on it will supply power when the system is off but still powered
by the AC/DC adapter plugged into a working outlet, or powered by the battery with a capacity level above 20% (this may
not work with certain devices - see page 8 - 12).

Icon Color Description Icon Color Description

Blinking Blue Hard Disk Activity Orange DC Power is Plugged In

Blue Number Lock is Activated Green The Computer is On

Blue Caps Lock is Activated Blinking Green The Computer is In Sleep Mode

Blue Scroll Lock is Activated Blinking Orange* The Powered USB Port is On*

Orange The Battery is Charging

Blinking Orange
The Battery has Reached Critically 

Low Power Status

Green The Battery is Fully Charged
System Map: LCD Panel Open & Top View 1 - 7
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Game Keys
The eight Game Keys on the left of the computer allow macros to be configured for common keystrokes used
in applications, as long as the driver is installed.

Figure 1 - 3 - Game Key Configuration
1 - 8 System Map: LCD Panel Open & Top View
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Touch Sensor Instant Keys
Press the Touch Sensor Instant Keys on the computer to toggle the appropriate function on/off. When a module
is powered on the appropriate icon will be highlighted. 

Table 1 - 2 - Touch Sensor Instant Keys

*When enabled, the Light Sensor will automatically adjust screen brightness according to the background en-
vironment.
**When enabled, Silent Mode will reduce fan noise and save power consumption. Note this may reduce com-
puter performance.

Icon Description Icon Description

*Light Sensor Toggle Wireless LAN Module Power Toggle

PC Camera Module Power Toggle  Activate the Default Internet Browser

Bluetooth Module Power Toggle THX TruStudio Pro Toggle (see page 7 - 64)

**Silent Mode Toggle Mute Toggle 

Volume Control Slider (move your finger slowly along the 
slider to adjust the system volume)
Touch Sensor Instant Keys 1 - 9
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Keyboard
The keyboard has an embedded numerical keypad for easy numeric data input, and
features function keys to allow you to change operational features instantly. See
Table 1 - 3, on page 1 - 11 for full function key combination details.

Figure 1 - 4 - Keyboard


Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial functions/hot-keys
unique to the system’s
regular keyboard may not
work.

Num Lk & Scr Lk

Hold down the Fn Key
and Scr Lk/Num Lk to en-
able scroll lock/number
lock, and check the LED
indicator for status. 

Numerical 

Play/Pause Key

Function Keys

NumLk & 
ScrLk Keys

Fn Key

 Keypad 

Game Control Keys



Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLk is on.
1 - 10 Keyboard
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Function Keys & Visual Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators (see the table below) are available when the Hot Key
driver is installed (see “Hot Key” on page 4 - 7). After installing the driver an icon  will appear in the taskbar.

Table 1 - 3 - Function Keys & Visual Indicators

Keys Function/Visual Indicators Keys Function/Visual Indicators

Fn + ~ Play/Pause (in Audio/Video Programs) Fn + F8/F9
Brightness 

Decrease/Increase 

Fn + F1 Touchpad Toggle Fn + F10
PC Camera Power 

Toggle

Fn + F2
Turn LCD Backlight Off 

(Press a key to or use Touchpad to turn on)
Fn + F11

WLAN Module 
Power Toggle

Fn + F3 Mute Toggle Fn + F12
Bluetooth Module 

Power Toggle

Fn + F4 Sleep Toggle Fn + NumLk Number Lock Toggle

Fn + F5/F6
Volume Decrease/

Increase 
Fn + ScrLk Scroll Lock Toggle

Fn + F7
Display Toggle

Note: DO NOT use the Fn + F7 key combination to toggle
through display options when SLI is enabled (see “SLI Multi
GPU Configuration” on page B - 14).

Fn + Power 
Button

Powered USB 2.0 Port Power Toggle
Keyboard 1 - 11
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System Map: Front & Rear ViewsFigure 1 - 5
Front View

1. Speakers
2. LED Power 

Indicators
3. DC-In Jack

See Appendix A for a more
detailed description of the
ports & jacks etc.

1 2

3

1

1 1
1 - 12 System Map: Front & Rear Views
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System Map: Right View Figure 1 - 6
Right View

1. Express Card Slot
2. Headphone-In Jack
3. Microphone-In Jack
4. Line-In Jack
5. S/PDIF-Out Jack
6. Combined eSATA/

USB Port
7. USB 2.0 Port
8. Security Lock Slot
9. Power Button

See Appendix A for a more
detailed description of the
ports & jacks etc.

2 3

6

54 7 8

9


USB Ports

Note that the connections to the USB ports only fit one way, do not force them.

1



ExpressCard Slot

The ExpressCard Slot accepts either ExpressCard/34 or ExpressCard/54 formats.
System Map: Right View 1 - 13
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System Map: Left ViewFigure 1 - 7
Left View

1. DVI-Out Port
2. USB 2.0 Port
3. USB 2.0 Port 

(Powered)
4. RJ-45 LAN Jack
5. HDMI-Out Port
6. Multi-In-1 Card 

Reader
7. 2 * USB 3.0 Ports
8. Mini-IEEE 1394a 

Port
9. Optical Device 

Drive Bay

See Appendix A for a more
detailed description of the
ports & jacks etc.


Mini-IEEE 1394a Port

The Mini-IEEE 1394 port
only supports SELF POW-
ERED IEEE 1394 devices.

1 2
4 5

6 7

9


Multi-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC

MS (Memory Stick) / MS Pro / MS Duo

HDMI Port

Note that the HDMI Port supports video and audio signals to attached external displays (also see “HD-
MI Audio Configuration” on page B - 18). Note that THX TruStudio Pro will be disabled when you are
connecting to an external display through an HDMI connection (see page 7 - 110).

USB 3.0 Ports & USB Port Power

USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. Note that the USB 3.0
port requires a driver installation (see “USB 3.0” on page 4 - 7) and is not operational under DOS. The
powered USB 2.0 port  can supply power when the system is off but still powered by the AC/
DC adapter plugged into a working outlet, or powered by the battery with a capacity level above
20% (this may not work with certain devices - see page 8 - 12). Toggle power to this port by
using Fn + power button.

3

8
3

1 - 14 System Map: Left View



Quick Start Guide 1

Disk Eject Warning

Don’t try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don’t try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.


Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.
System Map: Left View 1 - 15
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System Map: Bottom ViewFigure 1 - 8
Bottom View

1. Sub Woofer
2. Fan Outlet/Intake
3. Component Bay 

Cover
4. Battery 
5. HDD Bay

.


Overheating

To prevent your comput-
er from overheating make
sure nothing blocks the
vent(s)/fan intake(s)
while the computer is in
use.

1

2

4 5


Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 10 for full instructions.

3
2 2
1 - 16 System Map: Bottom View
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Windows 7 Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

Figure 1 - 9 - Start Menu & Control Panel

Click here to toggle Category View

 

System Map: Bottom View 1 - 17
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Video Features
You can switch display devices, and configure display options, from the Display control panel (in Appearances
and Personalization) in Windows 7 (see over). For more detailed video information see “NVIDIA Video Driver
Controls” on page B - 1.

To access Display (Control Panel) and Screen Resolution in Windows:

1. Click Start and click Control Panel.
2. Click Display (icon) - In the Appearances and Personalization category.
3. Click Adjust Screen Resolution/Adjust resolution.
OR
4. Alternatively you can right-click the desktop and select Screen resolution  (Figure 1 - 10 on page 1 - 19).
5. Use the dropbox to select the screen Resolution  (Figure 1 - 10 on page 1 - 19).

1
2


NVIDIA Video Driver Controls

More detailed video controls are provided by the NVIDIA Control Panel. For more detailed information see “NVIDIA Con-
trol Panel” on page 1 - 20 and Appendix B.

You can also access the control panels by right-clicking the desktop and selecting NVIDIA Control Panel (Figure 1 - 11
on page 1 - 20). 
1 - 18 Video Features
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Screen Resolution

Figure 1 - 10 - Screen Resolution

2


Video Options

Note that card types, specifi-
cations and drivers are sub-
ject to continual updates and
changes. Check with your
service center for the latest
details on video cards sup-
ported.

1

Video Features 1 - 19
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NVIDIA Control Panel
You can access the NVIDIA Control Panel as follows:

1. Click Start, and click Control Panel.
2. Click NVIDIA Control Panel  (Figure 1 - 11) - In the Appearances and Personalization category.
3. See “NVIDIA Video Driver Controls” on page B - 1 for full details on control panels etc.

OR
4. You can also access the control panel by right-clicking the desktop and selecting NVIDIA Control Panel .

Figure 1 - 11 - NVIDIA Control Panel

1

2

21
1 - 20 Video Features
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 17) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change plan settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 10.

Figure 1 - 12 - Power Options
Power Options 1 - 21
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Chapter 2: Storage Devices, Mouse, Audio & 
Printer

Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Optical Device
• Multi-In-1 Card Reader
• ExpressCard Slot
• Game Keys
• Audio Features
• TouchPad and Buttons/Mouse
• Adding a Printer
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive(s) is(are) used to store your data in the computer. The hard
disk(s) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives
with a height of 9.5 mm. The hard disk bay  is accessible from the bottom of your
computer as seen below.

The computer can accommodate up to three hard disks (two in the primary bay, and
one under the optical device), and these may be configured in RAID, AHCI or IDE
modes. Further details on removing and inserting the hard disk are available in “Up-
grading the Hard Disk Drive(s)” on page 6 - 5.


Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

 Figure 2 - 1
Hard Disk Bay

1

1

HDD Bay
2 - 2 Hard Disk Drive
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Optical Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the model you purchased (see “Storage” on page C - 2). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Boot Menu” on page 5 - 12).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator  will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole

 to open the tray.


Sound Volume 

Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting. 

Peripherals must be
connected before you
turn on the system.

 Figure 2 - 2
Optical Device

1

2

3

12 3
Optical Device 2 - 3
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Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.


CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
2 - 4 Optical Device
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DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 15.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, South 

Korea, The Philippines, Indonesia, 
Hong Kong

4
South & Central America, Mexico, 

Australia, New Zealand

5 N Korea, Russia, Eastern Europe, 
India & Most of Africa

6 China

Table 2 - 1
DVD Regional Coding
Optical Device 2 - 5
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 Multi-In-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “Card Reader” on page 4 - 7).

PC adapters may be required for some of these cards and are usually supplied with
them.


Card Reader Cover

Make sure you keep the
cover in the card reader
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the card read-
er.

 Figure 2 - 3
Right View

1. Card Reader

• MMC (MultiMedia Card) / RSMMC
• SD (Secure Digital) / Mini SD / SDHC / SDXC
• MS (Memory Stick) / MS Pro / MS Duo

1

2 - 6 Multi-In-1 Card Reader
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ExpressCard Slot
The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34. Make sure you install the Express-
Card driver (see “Card Reader/ExpressCard” on page 4 - 6).

Inserting and Removing ExpressCards
• Align the ExpressCard with the slot and push it in until it locks into place.
• To remove an ExpressCard, simply press the card to eject it.


ExpressCard 

Slot Cover

Make sure you keep the
cover in the Express-
Card slot when not in
use. This will help pre-
vent foreign objects and/
or dust getting in to the
ExpressCard Slot.

 Figure 2 - 4
Express Card Slot
ExpressCard Slot 2 - 7
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 Game Keys
The eight game hot keys on the left of the computer allow macros to be configured
for common keystrokes used in applications (the keys can assigned macros for any
program, not only games). To configure the keys follow the instructions below
(make sure you have installed the GameKey Utility driver - see “GameKey Utility”
on page 4 - 7).

1. Run the Game Key Configuration program from the desktop icon  (or from 
C:\Program Files\Chicony\GameKeys\GmKeyCfgUtl.exe).

2. Double-click the button  for the appropriate key (it will turn red ).
3. When the button is red  you may then record the keystrokes to be assigned to 

the Game Key.

4. Click OK.
5. Repeat the procedure for the other Game Key if required.
6. Close the Game Key Configuration window.
7. The keystroke order will be repeated with the appropriate button press in any 

application program.

Figure 2 - 5
Game Key 

Configuration
2 - 8 Game Keys
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Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the notifi-
cation area/control panel (right-click the notification area icon  to bring up an au-
dio menu). The volume may also be adjusted by means of the Fn + F5/F6 key
combination (see Table 1 - 3, on page 1 - 11). 


Volume Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the notification
area to check the set-
ting.

Headphone 
Configuration

It is recommended that
you set the Speaker
Configuration to Ste-
reo (not to 5.1 or 7.1
Speaker) when listening
through headphones in
order to maximize audio
quality.

 Figure 2 - 6
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.

See “HDMI Audio Configuration” on page B - 18 for a description of the audio configura-
tion when connecting an HDMI supported display device. 
See “THX TruStudio Pro Audio” on page 7 - 64 for more information on the THX TruStudio
Pro Audio setup.
Audio Features 2 - 9
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Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instruc-
tions below:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel) 
and make sure you are in Classic View.

2. Click Realtek HD Audio Manager (or right-click the notification area icon  and 
select Sound Manager).

3. Click Microphone Effects (tab) in Microphone (tab), and then click to select 
Noise Suppression (button), or adjust the Recording Volume level to around 60, 
to obtain the optimum recording quality.

4. Click OK to close the control panel and save the settings.

 Figure 2 - 7
Realtek Audio 

Manager - 
Recording Setup
2 - 10 Audio Features
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Suppressing Audio Background Noise
A background noise may occur when audio power management is enabled, and the
system resumes from power saving. To solve this problem you can disable Realtek
HD Audio Manager Power Management.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel) 
and make sure you are in Classic View.

2. Click Realtek HD Audio Manager (or right-click the taskbar icon  and select 
Sound Manager).

3. Click the Power Management icon .

 Figure 2 - 8
Realtek Audio 

Manager
Audio Features 2 - 11
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4. Make sure that Power Management is disabled (when disabled the icon will be 

black ; when enabled the icon will be blue ).
5. Click OK to save the setting and close the control panel.

 Figure 2 - 9
Realtek Audio 

Manager 
Power Management

The black icon      indicates that 
Power Management is disabled.
2 - 12 Audio Features
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Setup for 5.1 or 7.1 Surround Sound
To setup your system for 5.1 or 7.1 surround sound you will need to connect the au-
dio cables to the Headphone-Out, Line-In, Microphone-In jack and S/PDIF-Out
jacks (note: the S/PDIF jack is used for 7.1 surround sound only).

1. Click Start, and click Control Panel (or point to Settings and click Control Panel) 
and make sure you are in Classic View.

2. Click Realtek HD Audio Manager (or right-click the notification area icon  and 
select Sound Manager).

3. Click Speakers (tab) and click Speaker Configuration (tab).
4. Select 5.1 or 7.1 Speaker from the Speaker Configuration pull-down menu.


THX Audio & HDMI

Note that the THX audio
effects do not apply to
audio generated
through an HDMI con-
nection (see page 7 -
67).

Press the THX TruStu-
dio Pro Touch Sensor
Instant Key  to tog-
gle the THX TruStudio
AP On/Off.

 Figure 2 - 10
Speaker 

Configuration (7.1)


Auto Popup Dialog

You should enable the
auto popup dialog to au-
tomatically detect when a
device has been
plugged-in. If disabled,
double-click connector
settings  and click the
box to enable the auto
popup detection of
plugged-in devices.

Connector Settings
Audio Features 2 - 13
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5. Plug the front speaker cables into the Headphone-Out Jack.
6. Plug in the other cables (you may require an adapter to connect each cable to the 

appropriate jack e.g a stereo mini to dual RCA adapter) from your speakers as 
follows:

• Line-In Jack = Rear Speaker Out
• Microphone-In Jack = Center/Subwoofer Speaker Out
• S/PDIF-Out Jack = Side Speaker Out (for 7.1 Surround Sound Only)

7. As you plug in each cable a dialog box will pop up (see “Auto Popup Dialog” on 
page 2 - 13).

8. Click to put a tick in the appropriate box according to the speaker plugged-in (e.g. 
Rear Speaker Out), and then click OK to save the setting.

9. Click OK to exit Realtek HD Audio Manager. 

 Figure 2 - 11
Connected Device 

Auto Popup 

Note: Side Speaker Out is required for 7.1 Surround only.
2 - 14 Audio Features
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TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse. 

Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 7) you
can configure the functions from the Mouse control panel in Windows, or by double-
clicking the TouchPad driver icon  on the taskbar. You may then configure the
TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your
preferences. Use the Fn + F1 key combination to toggle the TouchPad on/off.


TouchPad Scrolling

This computer model se-
ries may feature different
TouchPad versions.

These TouchPads may
differ in their vertical
scrolling function in most
scrollable windows.

Some TouchPads require
sliding the finger up and
down on the right of the
TouchPad to scroll the
window. Other versions
require tapping/holding
down the finger at the top
right or bottom right of the
TouchPad to scroll the
window.

 Figure 2 - 12
Mouse Properties
TouchPad and Buttons/Mouse 2 - 15
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Gestures and Device Settings
The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
tion) on the surface of the Touchpad to perform specific actions to manipulate doc-
uments, objects and applications.

You can configure the settings from the Device Settings tab in Mouse Properties:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mouse (Hardware and Sound).
3. Click Device Settings (tab) and click Settings.
4. Use the menu tree on the left to access the user configurable settings.


Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture (Pinch
Zoom, Rotating, Three
Fingers Down and
Three Finger Flick) in the
Device Settings > Set-
tings left tree menu
and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

 Figure 2 - 13
Mouse Properties - 

Device Settings
2 - 16 TouchPad and Buttons/Mouse
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Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the
TouchPad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

Zooming
The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the TouchPad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.

 Figure 2 - 14
Scrolling Gesture


Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

 Figure 2 - 15
Zooming Gesture
TouchPad and Buttons/Mouse 2 - 17



Storage Devices, Mouse, Audio & Printer

2

Rotating
Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another
finger near the middle of the TouchPad and slide it in a circular motion around the
stationary finger (clockwise or counterclockwise) to rotate the object.

Three Finger-Flick/Three Fingers Down (Press)
The Three Finger-Flick gesture may be used to enhance navigation with a variety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-selectable applications.

 Figure 2 - 16
Rotating Gesture

 Figure 2 - 17
Flick/Press 

Gesture
2 - 18 TouchPad and Buttons/Mouse
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Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most new printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-

tridge etc.). 
2. Turn ON the computer.
3. Turn ON the printer. 
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you 

to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar
(you will need to purchase a parallel to USB converter).


Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
Adding a Printer 2 - 19
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Chapter 3: Power Management

Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the LCD and hard disk drive) or the whole system.

This chapter covers:

• The Power Sources
• Turning On the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.


OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows 7
OS.)
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components (see page C - 4).

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 14).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 10.
3 - 2 The Power Sources
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Turning On the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options in the Windows control panel to configure this feature.


Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

Power Button as 
Stand by or 

Hibernate Button

You can use the OS’s
Power Options control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page 3
- 8 for details).


Shut Down

Note that you should always shut your computer down by choosing the Shut Down com-
mand from the bottom right of the Start menu in Windows. This will help prevent hard disk
or system problems.
Turning On the Computer 3 - 3
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.


Resuming 
Operation

See Table 3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 1
Power Plan 

Advanced Settings
(Win 7)
3 - 4 Power Plans
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure 3 - 2
Power Plans (Win 7)

Click to Show/Hide 
additional 
power plans
Power Plans 3 - 5
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Win 7 uses the Sleep, Hibernate and Shut Down power-saving states.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.
3 - 6 Power-Saving States
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down
You should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.


Silent Mode

You can use Silent
Mode to reduce power
consumption and fan
noise. Use the Silent
Mode Touch Sensor In-
stant Key  to toggle
this mode on/off.

On screen visual indica-
tors  and the
Touch Sensor Instant
Key  will display the
Silent Mode status (see
Table 1 - 2, on page 1 -
9).

Note Silent Mode may
reduce computer perfor-
mance.

Figure 3 - 3
Start Menu Power
Power-Saving States 3 - 7
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state. Click Choose what the power buttons do on
the left menu in Power Options to bring up the menu.


Password 
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 4
Power Options 
Define Power 

Buttons
3 - 8 Configuring the Power Buttons
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad


Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table 3 - 1
Resuming 

Operation


Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).
Configuring the Power Buttons 3 - 9
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Battery Information
Follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
3 - 1 on page 3 - 4).

Click the battery icon  in the taskbar to see the current battery level and charge
status.


Low Battery 

Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 5
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
3 - 10 Battery Information
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.


Windows Mobility 

Center

The Windows Mobility
Center control panel
provides an easy point
of access for information
on battery status, power
plans used and wireless
device status etc.

Figure 3 - 6
Windows Mobility 

Center
Battery Information 3 - 11
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see “Removing the Battery”
on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 7 for information on the battery charge status, and to “Battery In-
formation” on page 3 - 10 for more information on how to maintain and properly
recharge the battery pack.)
3 - 12 Battery Information
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances.
• DO NOT expose the battery to fire or high temperatures, it may explode.
• DO NOT connect the metal terminals (+, -) to each other.


Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.


Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.
Battery Information 3 - 13
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure 3 - 7
Power Plan Create
3 - 14 Battery Information
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3. Click Change plan settings (after creating it) and click Change plan settings > 
Change advanced power settings.

Figure 3 - 8
Change Plan 

Settings / Change 
Advanced Power 

Settings
Battery Information 3 - 15
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 1%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 9
Power Options 

Advanced Settings - 
Battery
3 - 16 Battery Information
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.


SLI Multi GPU Configuration & Battery Power

Note that due to the high power and system demands created by enabling SLI Configura-
tion, you should not enable SLI configuration if your computer is powered by battery
only. If you attempt to run an SLI configuration when the computer is powered by the bat-
tery only, then system problems may occur.

If the computer is currently powered by battery only do not enable SLI configuration. 

If you have currently enabled SLI configuration, and the computer is powered by the AC/
DC adapter, do not switch to battery power only (or go to the NVIDIA Control Panel and
disable SLI configuration before switching to battery power only).
Battery Information 3 - 17
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware components for which the latest versions of most available op-
erating systems haven’t built in drivers and utilities. Thus, some of the system com-
ponents won’t be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the
Windows OS, and therefore before installing the other drivers listed here (see “Set-
ting Up SATA RAID or AHCI Mode” on page 7 - 2 and page 8 - 21).

What to Install
The Device Drivers & Utilities + User’s Manual disc contains the drivers and utili-
ties necessary for the proper operation of the computer. Table 4 - 1, on page 4 - 3
lists what you need to install and it is very important that the drivers are installed
in the order indicated. The procedures for installing drivers for the PC Camera,
WLAN, Fingerprint, Bluetooth and THX TruStudio Audio modules are provided
in “Modules” on page 7 - 1.


Driver Installation & 

Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).
What to Install 4 - 1



Drivers & Utilities

4

Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button), or Option Driv-
ers (button) to access the Optional driver menu.

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driver installation order from Table 4 - 1, 
on page 4 - 3 (the drivers must be installed in 
this order) which is the same as that listed in the 
Drivers Installer menu below.

2. Click to select the driver you wish to install, (you 
should note down the drivers as you install them).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

Figure 4 - 2 - Drivers Installer Screen 2
4 - 2 Driver Installation
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Table 4 - 1 - Driver Installation

Note that you need to install both the WLAN & Bluetooth drivers for Intel and 3rd party WLAN & Bluetooth
Combo modules.

If you are installing Hard Disk Drives with a combined capacity exceeding 2 Terabytes see “Partitioning
HDDs with a Combined Capacity Exceeding 2 TB” on page 8 - 21 for instructions.

Driver for Windows 7 with Service Pack 1*

Chipset Page 4 - 6
Intel Rapid Storage Technology 
(for RAID & AHCI mode Hard Disk Drives)

Page 7 - 9

Video (VGA) Page 4 - 6 PC Camera Module Page 7 - 15

LAN Page 4 - 7 Wireless LAN Module Page 7 - 23

Card Reader Page 4 - 7 Fingerprint Reader Module Page 7 - 43

TouchPad Page 4 - 7 Bluetooth Module Page 7 - 49

Hot Key Page 4 - 7 THX TruStudio Pro Audio Page 7 - 64

GameKey Utility Page 4 - 7 *Note all drivers provided are for Windows 7 with Ser-
vice Pack 1.USB 3.0 Page 4 - 7

MEI Driver Page 4 - 8

Audio Page 4 - 8
Driver Installation 4 - 3
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Manual Driver Installation
Click the Browse CD/DVD button in the Drivers In-
staller application and browse to the executable file in
the appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
9 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and 
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.
4 - 4 Driver Installation
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User Account Control
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue/Al-
low, and follow the installation procedure as directed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue the in-
stallation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.
Driver Installation 4 - 5
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button), or Option Driv-
ers (button) to access the Optional driver menu.

RAID Note: Setting up a RAID, or AHCI mode,
needs to be done prior to installing the Windows OS,
and therefore before installing the other drivers listed
here.

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video (VGA)
1. Click 2.Install VGA Driver > Yes.
2. Click AGREE AND CONTINUE (button) to 

accept the terms of the license agreement.
3. Click Next.
4. Click the RESTART NOW button to restart 

the computer.

After the Video (VGA) driver has been installed, and
the system restarted, the OS will automatically run the
"Winsat.exe" to rate the performance. Allow time for
this process to finish and do not restart during this pro-
cess (if you have restarted the system see “Windows
Update” on page 4 - 9).


Driver Installation General Guidelines

The driver installation procedure outlined in this
Chapter (and in Chapter 7 Options & Modules),
are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.
4 - 6 Driver Installation
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LAN
1. Click 3.Install LAN Driver > Yes.
2. Click Install.
3. Click Finish to complete the installation.

Card Reader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Install.
3. Click Finish to complete the installation.

TouchPad
1. Click 5.Install Touchpad Driver > Yes.
2. Click Next.
3. Click the button to accept the license, and then 

click Next.
4. Click Finish > Restart Now to restart the com-

puter.

Hot Key
1. Click 6.Install Hotkey AP > Yes.
2. Click Next > Next.
3. Click Finish > Finish to restart your computer.

GameKey Utility
1. Click 7.Install Gamekey AP > Yes.
2. Click Next.
3. Click Finish to restart the computer.
4. See “Game Keys” on page 2 - 8 for information.

USB 3.0
1. Click 8.Install USB 3.0 Driver > Yes.
2. Click Next.
3. Click the button to accept the license and then 

click Next.
4. Click Install > Finish.
Driver Installation 4 - 7
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MEI Driver
1. Click 9.Install MEI Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish.

Audio
1. Click 10. Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

After installing the audio driver the system will not re-
turn to the Drivers Installer screen. To install any of
the optional drivers, eject the Device Drivers & Utili-
ties + User’s Manual disc and then reinsert it (or dou-
ble-click the disc icon in My Computer), and click
Option Drivers (button) to access the optional driver
menu.

It is recommended that you install the THX Tru Stu-
dio Pro Audio application (see “THX TruStudio AP
Installation” on page 7 - 110) and Intel Rapid Stor-
age Technology driver (see “IRST Driver Installa-
tion” on page 7 - 8 - required for AHCI & RAID mode
hard disks).

(see over)
4 - 8 Driver Installation
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Optional Drivers
See the pages indicated for the driver installation pro-
cedures for any modules included in your purchase op-
tion.

Figure 4 - 3 - Optional Drivers Installer Screen


Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Click Check for updates (Security), or double-
click Security Center and click Windows Update.

3. Double-click Check for updates (button).
4. The computer will now check for updates (you 

need to be connected to the internet).
5. Click Install now (button) to install the updates.
Driver Installation 4 - 9
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RAID Setup
See “Setting Up SATA RAID or AHCI Mode” on
page 7 - 2.

PC Camera
See “PC Camera Module” on page 7 - 15.

Wireless LAN
See “Wireless LAN Module” on page 7 - 23.

Fingerprint Reader Module
See “Fingerprint Reader Module” on page 7 - 43.

Bluetooth Module
See “Bluetooth Module” on page 7 - 49.

THX TruStudio AP
See “THX TruStudio Pro Audio” on page 7 - 64.
4 - 10 Driver Installation
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Chapter 5: BIOS Utilities

Overview
This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.


BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages. 
Overview 5 - 1
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The Power-On Self Test (POST)
If you enable the Boot-time Diagnostic Screen in the Setup Utility, each time you
turn on the computer the system takes a few seconds to conduct a POST, including
a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.
5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct
configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.
The Power-On Self Test (POST) 5 - 3
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The Setup Utility
The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST. The prompt
“Press F2 to Enter Setup” is usually present for a few seconds after you turn on the
system. If you get a “Keyboard Error”, (usually because you pressed F2 too quickly)
just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.


BIOS Settings 

Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Pre-
vious Values with
<F2>, or Optimized De-
faults with <F3>.
5 - 4 The Setup Utility
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Setup Screens
The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make chang-
es to Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

If these tools are confusing, press F1 to call up a General Help screen, and then use
the arrow keys to scroll up or down the page.

The Item Specific Help on the upper right side of each screen explains the highlight-
ed item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.


Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.

Figure 5 - 1
Navigation Menu
The Setup Utility 5 - 5
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu
5 - 6 Main Menu
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SATA Port 0/1/2/3/4 (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA ports.

System/Extended Memory (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

BIOS Revision/ KBC/EC firmware Revision / VGA Card etc. (Main Menu)
This item contains information on the BIOS version and video card etc., and is not
user configurable.
Main Menu 5 - 7
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Advanced Menu

Advanced Chipset Control (Advanced Menu)
The sub-menu here allows you to adjust the Bluetooth Power Setting.

Figure 5 - 3
Advanced Menu
5 - 8 Advanced Menu
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Bluetooth Power Setting (Advanced Menu > Advanced Chipset Control)
You can adjust the Bluetooth module power setting to your preference. The default
setting (Disabled) will see the Bluetooth module powered off when the system is
started up or restarted. Enabling the power setting will have the module retain the
last power status (on or off) before any restart or shut down.

SATA Mode (Advanced Menu)
You can configure SATA (Serial ATA) control to operate in either AHCI (Ad-
vanced Host Controller Interface) or RAID (Redundant Array of Independent
Disks) modes from this menu. The SATA mode should be set BEFORE installing
an operating system, and after you have backed up all necessary files and data (see
sidebar). See “Setting Up SATA RAID or AHCI Mode” on page 7 - 2 for details if
you are configuring you hard disks in a RAID.

Legacy USB Support: (Advanced Menu)
Choose “Enabled” if you intend to use USB devices in systems which do not nor-
mally support USB functionality (e.g. DOS). The default setting is “Enabled” and
does not need to be changed if you intend to use your USB devices in Windows.

Boot Logo: (Advanced Menu)
Use this menu item to enable/disable the Boot Logo screen at system startup.


SATA Mode 

Selection

Set the SATA mode BE-
FORE installing your
Windows 7 operating
system. Do not change
the mode unless you in-
tend to reinstall your op-
erating system, and
make sure you back up
all necessary files and
data before doing so.

Note: If you are install-
ing Hard Disk Drives
with a combined capaci-
ty exceeding 2 Tera-
bytes see “Partitioning
HDDs with a Com-
bined Capacity Ex-
ceeding 2 TB” on
page 8 - 21 for instruc-
Advanced Menu 5 - 9
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Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
5 - 10 Advanced Menu
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.


Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Figure 5 - 4
Security Menu


Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
Security Menu 5 - 11
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows
7) from the devices listed in this menu, and in this priority order. If it cannot find
the operating system on that device, it will try to load it from the next device in the
order specified in the Boot priority order. Item specific help on the right is avail-
able to help you move devices up and down the order.

Figure 5 - 5
Boot Menu


BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages. 
5 - 12 Boot Menu
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Boot Option Priorities (Boot Menu)
Use the arrow keys to move up and down the menu and use the F5 and F6 keys to
move the device’s boot priority up and down the list (the selected device will be
highlighted in white).
Boot Menu 5 - 13
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Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

Figure 5 - 6
Exit Menu
5 - 14 Exit Menu
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Chapter 6: Upgrading The Computer

Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Battery
• Upgrading the Optical (CD/DVD) Device
• Upgrading the Hard Disk Drive(s)
• Upgrading the System Memory (RAM)
• Upgrading the Video Card

Please make sure that you review each procedure before you perform it.


Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.


Power Safety Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.


Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.
6 - 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.

1. Turn the computer off and turn it over.
2. Slide the latch  in the direction of the arrow.
3. Slide the latch  in the direction of the arrow, and hold it in place.
4. Lift the battery  up and out of the battery bay.
5. To reinsert the battery simply reverse this process.


Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 1
Battery Removal

1
2
3

12

3 3
Removing the Battery 6 - 3
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Upgrading the Optical (CD/DVD) Device
1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws  - .
3. Remove the hard disk bay and cover .
4. Remove the screw  from the optical device drive.
5. Push the optical device drive out of the bay and reverse the process to install a 

new ODD. 

Figure 6 - 2
Removing the CD/

DVD Device

1 3
4

5

1 2 3
4

5

6 - 4 Upgrading the Optical (CD/DVD) Device
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Upgrading the Hard Disk Drive(s)
The hard disk drive(s) can be taken out to accommodate other 2.5" serial (SATA)
hard disk drives with a height of 9.5mm (h) (see “Storage” on page C - 2). Follow
your operating system’s installation instructions, and install all necessary drivers
and utilities (as outlined in “Drivers & Utilities” on page 4 - 1), when setting up a
new hard disk. 

Note: If you are installing Hard Disk Drives with a combined capacity exceeding 2
Terabytes see “Partitioning HDDs with a Combined Capacity Exceeding 2 TB” on
page 8 - 21 for instructions.


HDD System Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.
Upgrading the Hard Disk Drive(s) 6 - 5
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Removing the Hard Disk(s) in the Primary HDD Bay
1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws  - .
3. Remove the hard disk bay and cover . 

Figure 6 - 3
Component Bay 
Cover Screws

1 3
4

1 2 3

4

6 - 6 Upgrading the Hard Disk Drive(s)
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4. Remove screws  -  from the hard disk assembly.
5. Disconnect the hard disk cable .
6. Remove the hard disk assembly by pulling the tab to lift the assembly out of the 

bay .

5 8
9

10

5 6

78

9

10

Figure 6 - 4
Bay Cover Removal 

& Hard Disk 
Assembly Screws
Upgrading the Hard Disk Drive(s) 6 - 7
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7. Remove screws  -  (depending on how many hard disks you have installed in 
the assembly).

8. Separate the hard disk board  from the case .
9. Separate the hard disk(s)  &  from the case.
10. Reverse the process to install any new hard disk(s).

Figure 6 - 5
Primary Hard 

Disk(s) Removal
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Removing the Hard Disk in the Secondary HDD Bay

1. Turn off the computer, and turn it over and remove the battery.
2. Remove the optical device drive “Upgrading the Optical (CD/DVD) Device” on 

page 6 - 4.
3. The secondary hard disk bay is located under the optical device drive.
4. Remove screws  - .
5. Remove the retaining pin  and disconnect the hard disk cable .
6. Lift the hard disk assembly  out of the compartment.

Figure 6 - 6
Secondary HDD 

Assembly Removal
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7. Remove the screws  -  to release the hard disk from the case .
8. Remove the cable .
9. Reverse the process to install any new hard disk(s).


HDD Installation

Make sure that when
you are reinserting the
retaining pin that it is
orientated as per the
picture below (see
also Figure 6 - 6 on
page 6 - 9).

Figure 6 - 7
Secondary HDD 

Case & Cable 
Removal

32 35 36
37

33

32

34

35

36

37
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Upgrading the System Memory (RAM)
The computer has three memory sockets for 204 pin Small Outline Dual In-line
(SO-DIMM) DDR III (DDR3) type memory modules (see “Memory” on page C -
2). The total memory size is automatically detected by the POST routine once you
turn on your computer.

Removing the Primary System Memory (2 memory sockets)

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws  - 

Figure 6 - 8
Component Bay 
Cover Screws

1 4

1 32 4
Upgrading the System Memory (RAM) 6 - 11
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3. Carefully (three fans and cables are attached to the under side of the cover) 
lift up the bay cover.

4. Carefully disconnect the fan cables  in the order ,  &  and remove the 
cover .

5. The primary memory sockets are visible at point .


Fan Cables

Make sure you discon-
nect the fan cables 
in the order ,  &

.

Figure 6 - 9
Component Bay 
Cover Removal
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C

5 A B C
6

7
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7

A
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6. Gently pull the two release latches (  & ) on the sides of the memory socket in 
the direction indicated below.

7. The RAM module  will pop-up, and you can remove it.

8. Pull the latches to release the second module if necessary.
9. Insert a new module holding it at about a 30° angle and fit the connectors firmly 

into the memory socket.
10. The module’s pin alignment will allow it to only fit one way. Make sure the module 

is seated as far into the socket as it will go. DO NOT FORCE the module; it should 
fit without much pressure.

11. Press the module in and down towards the mainboard until the socket levers click 
into place to secure the module.


Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

Figure 6 - 10
RAM Module 

Removal
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8

9

10
Upgrading the System Memory (RAM) 6 - 13



Upgrading The Computer

6

12. Reconnect the fan cables  in the order ,  & .
13. Reinsert the component bay cover , and secure with the screws  - .

14. Restart the computer to allow the BIOS to register the new memory configuration 
as it starts up.

15. Restart the computer to allow the BIOS to register the new memory configuration 
as it starts up.


Fan Cables

Make sure you connect
the fan cables  in the
order ,  & .

Figure 6 - 11
Component Bay 
Cover Screws & 
Cover Insertion
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6 1 4
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6

A

B
C

1 32 4
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Removing the Secondary System Memory (1 memory socket)

1. Turn off the computer, and turn it over and remove the battery.
2. Remove screws  &  from the bottom of the computer.

3. Turn the computer over, open the Lid/LCD, and carefully (a cable is connected to 
the underside of the LED cover module) unsnap up the LED cover module from 
point  on the right.

1 2
Figure 6 - 12

Bottom LED Cover 
Module Screws

Figure 6 - 13
LED Cover Module 

Removal

1 2

3

3
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4. Lift up the LED cover module  and disconnect cable .

5. Remove screws  -  from the keyboard.

6. Carefully lift the keyboard up, being careful not to bend the keyboard ribbon cable.

4 5

45

5

Figure 6 - 14
Keyboard Screws

Figure 6 - 15
Disconnect the 

Keyboard Locking 
Collar 

6 10 

76 8 9 10
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7. Disconnect the keyboard ribbon cable  from the locking collar socket .

8. Remove the keyboard , and then remove screws  -  from the keyboard 
shielding plate. 

11 12 

11

12

Figure 6 - 16
Keyboard Removal

Figure 6 - 17
Keyboard Shielding 

Plate Screws

13 14 16
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14

15

16
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9. Remove the keyboard shielding plate . 

10. Gently pull the two release latches (  & ) on the sides of the memory socket in 
the direction indicated below.

17 

17

Figure 6 - 18
Keyboard Shielding 

Plate Removal


Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

Figure 6 - 19
RAM Module 

Release Latches

18 19 

18

19
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11. The RAM module  will pop-up, and you can remove it.

12. Insert a new module holding it at about a 30° angle and fit the connectors firmly 
into the memory socket.

13. The module’s pin alignment will allow it to only fit one way. Make sure the module 
is seated as far into the socket as it will go. DO NOT FORCE the module; it should 
fit without much pressure.

14. Press the module in and down towards the mainboard until the socket levers click 
into place to secure the module.

15. Replace the screws, shielding plate and keyboard (make sure you reconnect the 
keyboard cable).

Figure 6 - 20
RAM Module 

Removal


Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

20

20
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16. Snap the LED cover module down at the top of the module at points  & .
17. Push the LED cover module down on the left side at point , and then slide the 

module to the right (as illustrated) and snap down to secure it in place.

18. Replace the screws on the bottom of the computer (see Figure 6 - 12).
19. Restart the computer to allow the BIOS to register the new memory configuration 

as it starts up.

Figure 6 - 21
LED Cover Module 
Slide to the Right & 

Snap Down


LED Module Cable

Make sure you recon-
nect the LED Module
cable  (see Figure 6
- 14).

5

21 22
23

21 22

23
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Upgrading the Video Card
If you intend to upgrade or add another VGA card follow the procedures outlined
here. However please check with your service representative first to make sure your
computer can support more than one video card, and that you are not going to void
your warranty. Pay careful attention to the alignment of any video card into the slot
on the mainboard.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws  - .
3. Carefully (three fans and cables are attached to the under side of the cover) 

lift up the bay cover.
4.Carefully disconnect the fan cables  in the order ,  &  and remove the 

cover .


Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 22
Component Bay 
Cover Screws & 
Cover Removal


Fan Cables

Make sure you discon-
nect the fan cables 
in the order ,  &

.
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5. Remove screws  -  in the order indicated on the label (and on the heat 
sink unit itself).

6. Remove the heat sink unit  (two heat sink units are pictured here).


Caution

The heat sink, and video
card area in general,
contains parts which are
subject to high tempera-
tures. Allow the area
time to cool before re-
moving these parts.

Figure 6 - 23
Heat Sink Screws & 
Heat Sink Removal
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7. Remove screws  &  from the video card (two video cards are pictured).
8. Carefully remove the video card .
9. If your system includes two video cards you will need to disconnect the cable  

between the master and slave cards (do not forget to reconnect the cable if you 
are replacing two cards).


Caution

The heat sink, and video
card area in general,
contains parts which are
subject to high tempera-
tures. Allow the area
time to cool before re-
moving these parts.

Figure 6 - 24
Video Card Removal
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Installing a New Video Card

1. Prepare to fit the video card into the slot by holding it at about a 30° angle.

2. The card needs to be fully into the slot, and the video card and socket have a 
guide-key and pin which align to allow the card to fit securely.


Contact Warning

Be careful not to touch
the metal pins on the
VGA card’s connecting
edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

Figure 6 - 25
Video Card 
Insertion
6 - 24 Upgrading the Video Card
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3. Fit the connectors firmly into the socket, straight and evenly.
4. DO NOT attempt to push one end of the card in ahead of the other.

5. The card’s pin alignment will allow it to only fit one way. Make sure the module is 
seated as far into the socket as it will go (none of the gold colored contact 
should be showing). DO NOT FORCE the card; it should fit without much 
pressure.

6. Press the card down onto the board using two hands at points  &  as 
indicated above.

Figure 6 - 26
Video Card Insertion 

Procedure

17

16

16 17
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7. Secure the card with screws  &  (Figure 6 - 24 on page 6 - 23).
8. Place the heatsink back on the card, and secure the screws in the order 

indicated in Figure 6 - 23 on page 6 - 22.
9. Reconnect the fan cables  in the order ,  & .
10. Reinsert the component bay cover , and secure with the screws  - .


Fan Cables

Make sure you connect
the fan cables  in the
order ,  & .

Figure 6 - 27
Component Bay 
Cover Screws & 
Cover Insertion
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Chapter 7: Modules

Overview
This chapter contains information on the various modules (some of which are op-
tional) which may come with your computer, depending on the configuration pur-
chased. If you are unsure please contact your service representative.

The chapter includes information on the following:

• Setting Up SATA RAID or AHCI Mode
• PC Camera Module
• Wireless LAN Module
• Fingerprint Reader Module
• Bluetooth Module
• THX TruStudio Pro Audio
Overview 7 - 1
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Setting Up SATA RAID or AHCI Mode
AHCI Mode
Advanced Host Controller Interface (AHCI) is an interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance). AHCI mode can be
supported by one or two hard disks. Make sure you install the Intel® Rapid Storage
Technology application if you have set up your hard disk(s) in AHCI mode (see
“Intel Rapid Storage Technology” on page 7 - 9)

RAID
To configure your RAID (Redundant Array of Independent Disks) system in Strip-
ing (RAID 0), Mirroring (RAID 1) or Recovery modes (see Table 7 - 1, on page 7 -
3) you will require at least two identical (see sidebar) hard disks; to configure your
system in Parity Across Disks (RAID 5) mode you will require three hard disks in-
stalled. Note that if you are using Advanced format hard disks that have a 4KB
physical sector size, and you are installing a Windows 7 release pre Service Pack
1, you will need to install a driver from the Device Drivers & Utilities + User’s Man-
ual disc at OS installation (see page 8 - 18).

Intel® Rapid Storage Technology Application
Make sure you install the Intel® Rapid Storage Technology application if you
have set up your hard disk(s) in RAID mode (see “Intel Rapid Storage Technolo-
gy” on page 7 - 9).


RAID Hard Disks

All hard disks in a RAID
should be identical (the
same size and brand) in
order to prevent unex-
pected system behavior.

Note: If you are install-
ing Hard Disk Drives
with a combined capaci-
ty exceeding 2 Tera-
bytes see “Partitioning
HDDs with a Com-
bined Capacity Ex-
ceeding 2 TB” on
page 8 - 21 for instruc-
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RAID Level Description

RAID 0
Two Identical drives reading and writing data in parallel to increase performance. 
RAID 0 implements a striped disk array and the data is broken into blocks and each 
block is written to a separate disk drive.

RAID 1

Two Identical drives in a mirrored configuration used to protect data. Should a drive 
that is part of a mirrored array fail, the mirrored drive (which contains identical data) will 
handle all the data. When a new replacement drive is installed, data to the new drive is 
rebuilt from the mirrored drive to restore fault tolerance.

RAID 5
Identical drives (at least three drives must be used) in a parity across disks 
configuration are used to protect data and increase performance. A RAID 5 array 
can withstand a single disk failure without losing access to data.

Recovery
Two Identical drives copying data between a master and a recovery disk. This provides 
more control over how data is copied between the master and recovery drives, fast 
volume updates and the ability to view the data in Windows Explorer.

Table 7 - 1
RAID Levels


Array Types

A Mirrored Array
(RAID 1) provides full
data protection, as
data can simply be
copied from a healthy
disk to a replacement
for any failed disk.

A Striped Array
(RAID 0) is NOT fault-
tolerant. The failure of
one drive will result in
the loss of all data in
the array. It is de-
signed to increase disk
performance by
spreading the I/O load
across the channels
and drives.


SATA Mode Selection

The SATA mode selection should be made before installing your operating system. 

DO NOT change your selected SATA mode unless you intend to reinstall your operating
system. Make sure you have backed up all your data before doing so.
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Prepare the following before setting up your serial ATA hard disks in RAID mode
(to configure AHCI mode you do not need to prepare any extra hard disks but will
need to install the Intel® Rapid Storage Technology application):

1. The Microsoft Windows 7 OS DVD.
2. A hard disk installed in the Primary HDD bay.

AND
For RAID levels 0/1 and Recovery: A second (identical) hard disk installed in the 
Primary HDD bay.
For RAID level 5: A third (identical) hard disk installed in the Secondary HDD bay.

3. The Device Drivers & Utilities + User’s Manual disc.

Note: If you are using Advanced format hard disks that have a 4KB physical sec-
tor size, and you are installing a Windows 7 release pre Service Pack 1, you will
need to install a driver from the Device Drivers & Utilities + User’s Manual disc at
OS installation (see page 8 - 18).

Note: If you are installing Hard Disk Drives with a combined capacity exceeding 2
Terabytes see “Partitioning HDDs with a Combined Capacity Exceeding 2 TB” on
page 8 - 21 for instructions.
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SATA RAID Setup Procedure (BIOS)
1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select "SATA Mode" and press Enter (see page 5 - 8).

• Select “RAID Mode”.

3. Go to the Boot menu.
4. Set the DVD-ROM Drive (make sure the Microsoft Windows 7 OS DVD is

inserted) as the first device in the boot order from the Boot menu (see “Boot
Menu” on page 5 - 15).

5. Select Save Changes and Reset from the Exit menu (or press F4 and Enter) and
press Enter to exit the BIOS and reboot the computer.

6. See the instructions in “RAID Setup (Intel Matrix)” on page 7 - 6.
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RAID Setup (Intel Matrix)
1. As the computer starts up press Ctrl + i to enter RAID configuration menu.

2. Select 1.Create RAID Volume and press Enter.
3. Type the RAID volume name and then press Tab or Enter to advance to the next 

field.
4. Specify (use the up and down arrow keys) the RAID level (RAID 0, RAID 1 or 

Recovery - see Table 7 - 1, on page 7 - 3) and then press Tab or Enter to 
advance to the next field.

Figure 7 - 1
Intel(R) Rapid 

Storage Technology 
Option ROM


Recovery Level

When selecting disks for
the Recovery RAID level
you will need to use the
Tab key to select a Mas-
ter disk, and the Space
key to select a Recov-
ery disk.

You can select the syn-
chronization between
the disks to be Continu-
ous (automatic) or On
Request (manually).
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5. Press Enter and the system will select the physical disks to use (see sidebar for 
Recovery Level).

6. Press Enter and select (if applicable) the Strip Size (best set to default).
7. Press Enter and select the Capacity size (best set to default).
8. Press Enter to select Create Volume.
9. Press Enter to create the volume, and confirm the selection by pressing Y.
10. This will now return to the main menu.

11. Select 6.Exit and press Enter, then press Y to exit the RAID configuration menu.


Recovery Level

When selecting disks for
the Recovery RAID level
you will need to use the
Tab key to select a Mas-
ter disk, and the Space
key to select a Recov-
ery disk.

You can select the syn-
chronization between
the disks to be Continu-
ous (automatic) or On
Request (manually).

Figure 7 - 2
RAID Created
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12. Make sure the Windows 7 OS DVD is in the DVD drive. and as the computer 
starts up it will automatically boot from the Windows 7 OS DVD (you will be 
prompted to press a key to boot from the DVD).

13. Press Enter to continue installing the operating system as normal (see your 
Windows documentation if you need help on installing the Windows OS - see 
sidebar).

14. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual 
disc as per Table 4 - 1, on page 4 - 3 (make sure you install the Intel Rapid 
Storage Technology driver - see “IRST Driver Installation” on page 7 - 9).


Win7 (pre SP1) & 
Advanced Format 
Disks in a RAID

Note that if you are in-
stalling a Windows 7
OS pre Service Pack 1,
and you are using Ad-
vanced format hard
disks that have a 4KB
physical sector size,
you will need to install a
driver from the Device
Drivers & Utilities +
User’s Manual disc at
OS installation (see
page 8 - 18).
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Intel Rapid Storage Technology
The Intel Rapid Storage Technology application provides high-performance
SATA and SATA RAID capabilities. Install the Intel Rapid Storage Technology
application to support your RAID system or SATA drive if set up in AHCI mode
in the BIOS (see “SATA Mode (Advanced Menu)” on page 5 - 9). Make sure you
have installed all the drivers from the Device Drivers & Utilities + User’s Manual
disc as per Table 4 - 1, on page 4 - 3 before installing the IRST driver.

IRST Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 6.Install IRST Driver > Yes.
4. Click (click the tickbox if you want to install the Intel® Control Center - 

see sidebar) Next > Next > Yes > Next > Next.
5. Click Finish to restart the computer (you will need to restart the system 

again after the computer has rebooted).

See the following pages for more information if you have set your hard disks up in
a RAID configuration.


Intel® Control 

Center

The Intel® Control
Center provides a cen-
tral starting point to
make it easier to find
any Intel® programs you
need to use. 

Click the tickbox in the
first installation screen
of the setup program to
install the control center.
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Intel® Rapid Storage Technology for RAID Systems
Intel® Rapid Storage Technology application displays status information on your
RAID configuration. Run the Intel® Rapid Storage Technology application from
the Intel item in the All Programs menu.

When the Intel® Rapid Storage Technology application is launched the system
will open the Status window. Here you can view the general health of the storage
system. Various volume creation and management options are available depending
on the system’s status.

Figure 7 - 3
Intel® Rapid 

Storage Technology
 Status
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Intel® Rapid Storage Technology Help
If a hard drive member of a RAID volume is reported as “Degraded” or “Failed” it
may be possible to recover the volume. If the volume cannot be restored then you
will need to recreate the RAID volume and restore the data from a back up. Click the
Help menu (or press F1) for instructions on how to recover or recreate RAID Vol-
umes.


Help

Click the Help (or
press F1) menu button
at the top of the Intel®
Rapid Storage Tech-
nology application.

Click Contents to view
the general list of sub-
jects covered, click In-
dex or Search for a
more specific help top-
ics on a particular item.

Click More help on
this page at the bot-
tom of any page for
page specific help.

Figure 7 - 4
Intel® Rapid 

Storage 
Technology

 Help
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RAID Volume Data Verification and Repair
The RAID volume data verification process identifies any inconsistencies or bad
data on a RAID 0, RAID 1 or RAID 5 volume. The table outlines what occurs for
each RAID level:

Replacing and Reverting Recovery and Master Volumes
If a master or recovery drive fails you will need to add a new identical drive and re-
build the recovery volume to the drive. You can also revert the master drive to the
state of the previous volume update. For details on how to do this see the help file
“Intel® Rapid Storage Technology Help” on page 7 - 11.See over for details on
how to verify and repair RAID volume data. Verification will identify and repair
data inconsistencies on the volume.

RAID 
Level

Verify Verify & Repair

RAID 0 Bad blocks are identified. N/A

RAID 5

Bad blocks are identified.

Parity is recalculated and compared 
to the stored parity for that stripe.

Bad blocks are reassigned.

If the newly calculated parity does not match the 
stored parity, the stored parity is overwritten with the 
newly calculated parity.

RAID 1

Bad blocks are identified.

Data on the mirrored drive is 
compared to data on the source 
drive.

Bad blocks are reassigned.

If the data on the mirrored drive does not match the 
data on the source drive, the data on the mirrored 
drive is overwritten by the data on the source.

Table 7 - 2
RAID Level 

Verification & 

Repair Status
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Verifying and Repairing RAID Volume Data
1. Before verifying the volume data you will need to initialize the volume.
2. Run the Intel® Rapid Storage Technology application from the Intel item in the 

All Programs menu.
3. Click Manage and click Advanced.
4. Click Initialize and click Yes (button) to begin the process.
5. The completion percentage will be listed under Status.

Figure 7 - 5
Intel® Rapid 

Storage 
Technology

 Initialize

The completion percentage 
will be listed under Status.
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6. Click Advanced and click Verify, then click Verify (button) to begin the process.
7. The completion percentage will be listed under Status (verifying and repairing).

Figure 7 - 6
Intel® Rapid 

Storage 
Technology

 Verify

The completion percentage 
will be listed under Status.
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PC Camera Module
Before installing the driver, make sure the PC Camera is on. Use the Fn + F10 key
combination or Touch Sensor Instant Key  to toggle power to the PC Cam-
era module. When the PC Camera module is powered on the  LED will be
highlighted and the indicator  will briefly be displayed. Make sure you install
the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

There are a number of different camera modules available with this computer model
series. You will have the appropriate application installed for your camera (note that
some versions of the camera application do not support the zoom function). Make
sure you access the application via the desktop shortcut.


Latest PC Camera 
Driver Information

Check the Device Drivers
& Utilities + User’s Manu-
al disc and any accompa-
nying insert pages, for the
latest updated information
on the PC Camera driver,
which may override the in-
formation provided here.

PC Camera Display

The PC Camera applica-
tion software needs to be
run while the default note-
book LCD is the selected
display device.

After a camera picture is
obtained on the default
notebook LCD, you may
then use the Fn + F7 to tog-
gle through the display
modes (give the screen
time to refresh).


PC Camera Application and Power-Saving States

If the computer enters Sleep or Hibernate mode while running the camera application, the
program will stop running, and will need to be restarted when the system resumes from the
power-saving state.
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PC Camera Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install Webcam Driver > Yes.
4. Click Next > Finish to restart the computer.

Run the camera application program from the desktop shortcut (if the hard-
ware is turned off use the Fn + F10 key combination to turn it on again).
7 - 16 PC Camera Module
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is 

not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
7. Click OK and close the control panels.
8. Run the camera application program from the desktop shortcut.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should 

have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick 

alongside it).
11. To obtain the best sound recording quality enable Noise Suppression in the 

Realtek HD Audio Manager control panel (see “Setup for Audio Recording” on 
page 2 - 10).
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Figure 7 - 7
Audio Setup for PC 

Camera

Right-click
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Camera Application
The camera application is a video viewer for general purpose video viewing and test-
ing, and for capturing video files to .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you 
set the capture file before the capture process - see below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page 7 - 17) and select Start Capture.

3. Click OK/Yes (the file location will be displayed in the pop-up box) to start 
capturing the video, and press Esc to stop the capture (you can view the file using 
the Windows Media Player).

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and location before capture (this will help avoid ac-
cidentally overwriting files). Set the name and location then click Open, then set the
"Capture file size:" and click OK. You can then start the capture process as on the
previous page.

Note the important information in “Reducing Video File Size” on page 7 - 20 in
order to save file space, and help prevent system problems.
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Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows system requires a minimum of 15GB of free space on the C:
drive system partition. In order to prevent system problems it is recommended that
you save the captured video file to a location other than the C: drive (see “Set Cap-
ture File” on page 7 - 19), limit the file size of the captured video or reduce video
resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the camera application program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to 

reduce the captured file size.
4. Click OK.
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Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to
adjust the setting in the Video Capture Filter options.

1. Run the camera application from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency (Anti Flicker).


Latest PC Camera 
Driver Information

Check the Device Driv-
ers & Utilities + User’s
Manual disc, and any
accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here, including the fig-
ures pictured here.

Figure 7 - 8
Video Capture Filter
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Taking Still Pictures
The camera application allows you to take still pictures.

1. Run the camera application from the desktop shortcut.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder  on the 

desktop.


Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.
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Wireless LAN Module
If you have included an Intel® or 3rd Party 802.11b/g/n WLAN module in your
purchase option, make sure that the Wireless LAN module is on before installing the
driver.

Use the Fn + F11 key combination or Touch Sensor Instant Key  to toggle
power to the Wireless LAN module. When the WLAN module is powered on, the

 LED will be highlighted and the indicator  will briefly be displayed.
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.
The operating system is the default setting for Wireless LAN control in Windows 7.

Note that you need to install both the WLAN & Bluetooth drivers for Intel and 3rd
party WLAN & Bluetooth Combo modules.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination/Touch Sensor Key
to toggle power to the
WLAN module, and check
the LED to see if the mod-
ule is powered on or not
(see Table 1 - 3, on page 1
- 11/ Table 1 - 2, on page 1
- 9).
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Intel® Wi-Fi Link Series Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1. Make sure the module is powered on, then insert the Device Drivers & Util-
ities + User’s Manual disc into the CD/DVD drive. 

2. Click Option Drivers (button).
3. Click 2.Install WLAN Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Next > Finish.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see overleaf).

802.11b/g/n Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Util-

ities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows 7 (see overleaf).


Intel(R) PROSet/ 

Wireless

Access the Intel PRO-
Set Wireless tools (Sta-
tistics and Diagnostic
tools) from the Start
menu (Start > Pro-
grams/All Programs >
Intel PROSet Wire-
less). These tools pro-
vide diagnostic and
statistical information
only (use the WLAN
control in Windows to
connect to a WLAN ac-
cess point).
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Connecting to a Wireless Network in Windows 7
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then double-click an access point to con-
nect to or click to Open Network and Sharing Center if you do not see a network 
you want to connect to in the taskbar menu (a list of options will appear allowing 
setting changes, and creating a new network).


Network and 

Sharing Center

You can also use the Net-
work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 9
Click Taskbar Icon 
Menu & Network 

and Sharing Center
Wireless LAN Module 7 - 25



Modules

7

2. You may need to enter a security key for any access point to which you are trying 
to connect.

3. Click to select a network location (e.g. Home, Work or Public).
4. Click “View or change settings in Network and Sharing Center” to access 

further options for the connection.

Figure 7 - 10
Network Location 

Set
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5. Click the taskbar icon  to see any currently connected networks.
6. To disconnect from the wireless network you can click the taskbar wireless icon ,

click the active connection and then click Disconnect (button).


Security Enabled 
Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure net-
works may allow unauthor-
ized access to your
computer, documents, web-
sites and files etc.

Figure 7 - 11
Click Taskbar Icon 

Menu - Disconnect
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Intel® My WiFi Configuration
Intel® My WiFi Technology uses your WLAN (for Intel WLAN modules only)
module to allow you to connect up to eight other WiFi enabled devices (e.g. digital
cameras, other computers, cell phones, handheld devices etc.) to your computer
(similar to Bluetooth), while still connecting to the Internet through your WiFi wire-
less connection. Intel® My WiFi Technology offers greater range and speed than
other personal area networks, and does not require an access point.


Intel® My WiFi Help

To get help on Intel®
My WiFi configuration
and settings, access the
Intel® My WiFi Utility
from the Start menu
(Start > Programs/All
Programs > Intel PRO-
Set Wireless > Intel My
WiFi Technology), or by
clicking the notification
area icon . Click the
Help icon  and
select a help topic from
the Contents menu.
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Intel® My WiFi Configuration
You can configure the My WiFi settings as follows.

1. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All 
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by double-
clicking the notification area icon .

2. Click Enable  (on the first run of the program there will be no connected 
devices listed).

Figure 7 - 12
Intel® My WiFi 

Utility
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3. Click Start and click Control Panel.
4. Click Network and Sharing Center (Network and Internet). 
5. Click Change adapter settings. 

Figure 7 - 13
Network and 

Sharing Center

Click Change 
adapter settings 
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6. Right-click Wireless Network Connection and select Properties.

Figure 7 - 14
Network 

Connections

Right-click Wireless Network
Connection and select Proper-
ties. 
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7. Click Sharing (tab) and select “Allow other network users to connect through 
this computer’s Internet connection”.

8. Select Wireless Network Connection under Home networking connection.
9. Click OK.

Figure 7 - 15
Wireless Network 

Connection 
Properties - 

Sharing

Click “Allow other network
users to connect through
this computer’s Internet
connection”.

Select Wireless Network
Connection.
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10. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All 
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by double-
clicking the notification area icon .

11. Click Profiles .

Figure 7 - 16
Intel® My WiFi 
Utility - Profiles
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12. Click Profiles, click Intel Wireless PAN and click Edit or New (Note that all 
preset settings may not be editable - see sidebar).

13. You can change the Profile Name and Network Name to your personal 
preferences in General (tab).

Figure 7 - 17
Profiles


Profile Settings

Profiles that are preset
may not be fully edit-
able. To edit all the
profile settings, click
New to create a new
profile and adjust the
settings to your prefer-
ences.

Figure 7 - 18
Intel® My WiFi 

Profile Settings - 
General


Profile and Network Names

The Profile Name is the name as dis-
played on your computer in the Net-
work Connections control panel
(see Figure 7 - 19 on page 7 - 35).

The Network Name (SSID) is the
name the devices see when they try
to connect to your computer.
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14. Click Security (tab).
15. Change the Security Type to WEP and the Encryption Type to 64bit.
16. Enter a password (8 characters long) in the Password box. 

Figure 7 - 19
Intel® My WiFi 

Profile Settings - 
Security
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17. Click Sharing (tab).
18. It is recommended that the Filter Network Traffic and DHCP and DNS Server 

are Disabled. 

Figure 7 - 20
Intel® My WiFi 

Profile Settings - 
Sharing
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19. Click Advanced (tab).
20. It is recommended that the Default Channel is set to Channel 1, 6 or 11.
21. Click OK to save the settings. 

Figure 7 - 21
Intel® My WiFi 

Profile Settings - 
Advanced
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22. Double-click Wireless Network Connection in Network Connections.
23. Click Details to display the Network Connection Details.

Figure 7 - 22
Wireless Network 

Connection Details
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24. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All 
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking 
the notification area icon .

25. To add a new device follow the instructions in the devices’ user guide for 
connecting to a WiFi network.

26. Click Add New Device in Intel® My WiFi Utility to confirm the security settings 
detail.

Figure 7 - 23
Intel® My WiFi 

Utility 
(Add New Device)
Wireless LAN Module 7 - 39



Modules

7

Intel WLAN & Bluetooth Combo Module High-Speed Data 
Transfer Configuration
You will need to configure the following settings to enable high-speed wireless data
transfer as supported by Intel Wireless LAN & Bluetooth Combo modules (note this
information applies to Intel WLAN & Bluetooth Combo modules only).

1. Go the Windows control panel and double-click Device Manager (in Hardware 
and Sound under Devices and Printers).

Figure 7 - 24
Devices and 

Printers 
(Device Manager)
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2. Click Network adapters to expand the sub-menu.
3. Double-click the Intel WiFi Link .... module.
4. Click Advanced (tab).
5. Click 802.11n Channel Width for band 2.4 under “Property:”.
6. Click the pull-down menu under “Value:”
7. Click to select Auto.
8. Click OK and close the control panels.

Figure 7 - 25
Intel WiFi Link 

Properties 
(Advanced)
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Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click Start, and click Control Panel (or point to Settings and click Control 
Panel).

2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon  to access the network 

menu.

Figure 7 - 26
Windows Mobility 

Center
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Fingerprint Reader Module
(Optional)
The fingerprint reader Protector Suite Software provides a high level of security
for your computer. A further level of security and control is provided in the BIOS
(see “Security Menu” on page 5 - 11).

The fingerprint reader and Protector Suite Software allow you to:

• Access or Lock your computer
• Protect sensitive files
• Display and file your favorite web pages
• Fill in frequently used dialogs
• Run your favorite applications

If you have included the fingerprint reader in your purchase option you will need to
install the driver as per the instructions below. 

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.


Password Warning

If you set passwords for
any of the security mod-
ules, NEVER forget your
password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive. 
2. Click Option Drivers.
3. Click 3.Install FingerPrint Driver > Yes.
4. Click Next > Next > Next.
5. Click Finish > Yes to restart the computer.
6. Click the tray icon , scan a finger or click Start > Programs/All Pro-

grams > Protector Suite > Control Center and then begin the enrollment 
process (see over).
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User Enrollment
1. Click Start > Programs/All Programs > Protector Suite > Control Center, or 

double click the notification area icon  (click Initialize).
2. On the first run of the program you will be asked to click the Accept button to 

accept the license.
3. If you have not set a Windows password you will be prompted to do so (note: If 

you have not set a password Protector Suite cannot secure access to your 
computer).

4. Click Submit when you have entered password.
5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get 

help with fingerprint enrollment at any time).


Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 7 - 27
Fingerprint 
Enrollment

Tutorial
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6. Click the button above any of the fingers to begin the enrollment process for that 
finger.

7. Swipe the finger until the progress bar reaches 100% to enroll that finger.
8. Repeat the process for all the fingers you wish to enroll (see sidebar), and then 

click Save and Continue.
9. Enter a backup password and click Apply.
10. Close the fingerprint status window.


Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 7 - 28
Fingerprint Status
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11. Right-click the taskbar icon  and select Start Control Center (and then swipe a 
finger) to allow you to Edit Fingerprints, register Applications, edit Settings and 
access the Help menu etc. You can also run the Control Center etc. from the 
Protector Suite item in the Programs/All Programs menu

12. Click “Help” in Control Center Home to get more information on any topic.
13. You can also run the Tutorial, or Product Tour video to get more information.

14. See “Help” on page 7 - 48 for further details.
15. If you swipe your finger over the reader at any time you can access the Biomenu 

to lock the computer, register websites, access the Personal Safe, open the 
Control Center and access the Help menu.

Help

Figure 7 - 29
Control Center & 

Biomenu 
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Fingerprint Control Center Features

Application Launcher
The Application Launcher allows you to register applications to be launched when
assigned to a particular finger. Simply copy the application icon on to one of the reg-
istered fingers and ten click OK to close the application window. Once registered the
application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other set-
tings for web sites etc. 

Personal Safe
The Personal Safe is an encrypted area assigned on your hard drive that allows you
to store files and folders to be protected by fingerprint protection.


Help

For more information on
these and other features
simply access “Help” in
the Fingerprint Control
Center and select the
item from the menu on
the left.
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Bluetooth Module
If your purchase option includes the Combination Wireless LAN & V3.0 Blue-
tooth module (either Intel® Centrino® Wireless-N 1030, Intel® Centrino Ad-
vanced-N 6230 or 3rd Party) then install the driver as instructed.

If your purchase option includes a standard V2.1 Bluetooth module, then the op-
erating system’s Bluetooth Devices control panel is used to configure the Bluetooth
settings in Windows 7, and therefore does not require a driver.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see Table 1
- 3, on page 1 - 11/ Table 1
- 2, on page 1 - 9).


Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is sup-
ported in one direction only (simultaneous data transfer is not supported). Therefore if you
are copying a file from your computer to a Bluetooth enabled device, you will not be able to
copy a file from the Bluetooth enabled device to your computer until the file transfer process
from the computer has been completed.
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Use the Fn + F12 key combination or Touch Sensor Instant Key  to toggle
power to the Bluetooth module. When the Bluetooth module is powered on the

 LED will be highlighted and the indicator  will briefly be displayed.

• For 3rd party Bluetooth V2.1 +EDR modules see “Standard Bluetooth Con-
figuration in Windows 7” on page 7 - 60 (no driver is required).

• For 3rd party Bluetooth combo modules see “3rd Party Bluetooth Combo 
Driver Installation” on page 7 - 51 and “3rd Party Bluetooth & WLAN Combo 
Settings” on page 7 - 52.

• For Intel Bluetooth combo modules see “Intel Bluetooth Combo Driver 
Installation” on page 7 - 59 and “Standard Bluetooth Configuration in Win-
dows 7” on page 7 - 60.
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3rd Party Bluetooth Combo Driver Installation
Note this driver is required only for the combo Bluetooth and WLAN module only.

1. Before installing the driver make sure the Bluetooth module is powered 
on (use Fn + F12 key combination), then insert the Device Drivers & Utili-
ties + User’s Manual disc into the CD/DVD drive. If a Found New Hard-
ware window appears, click Cancel in all windows that appear, and then 
proceed to install the driver as below.

2. Click Option Drivers (button).
3. Click 4.Install Combo BT Driver > Yes.
4. Choose the language you prefer and click OK.
5. Click Next.
6. Click the button to accept the license and click Next.
7. Click Next > (select if you want to create an icon to appear on the desktop) 

Next > Install.
8. Click Finish.
9. The My Bluetooth icon  will appear on the desktop and the Bluetooth 

item will be installed in the Programs/All Programs menu.
10. See “3rd Party Bluetooth Networking Setup” on page 7 - 55 for informa-

tion on Bluetooth networking.


High Speed Bluetooth 

Data Transfer

The Combination Wire-
less LAN & V3.0 Blue-
tooth module supports
high speed (V3.0) data
transfer. However to
achieve such transfer
speeds, both devices
must support high
speed data transfer.

To obtain high speed
(V3.0) data transfer
make sure that both the
WLAN and Bluetooth
modules are powered
on.

Check your Bluetooth
compatible device’s doc-
umentation to confirm it
supports high speed data
transfer.
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3rd Party Bluetooth & WLAN Combo Settings
This information applies to the combo Bluetooth and WLAN module only.

1. Make sure the Bluetooth module is powered on.
2. Double-click the My Bluetooth application on the desktop (or access it from the 

Programs/All Programs menu).
3. Click My Bluetooth Settings (menu heading).


Bluetooth Module & 

Resuming From Sleep 
Mode

The Bluetooth module’s de-
fault state will be off after re-
suming from the Sleep
power-saving state. Use the
key combination (Fn + F12)
to power on the Bluetooth
module after the computer
resumes from Sleep.

Figure 7 - 30
My Bluetooth 

Settings
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4. Click General Settings  to change the computer name that other Bluetooth 
devices will see, and click the tickbox to Allow Bluetooth devices to find this 
computer

5. Click OK to confirm the settings.

Figure 7 - 31
General Settings
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6. Click File Transfer Settings  to Enable sharing of my files with other 
Bluetooth devices.

7. Click OK to confirm the settings.

Figure 7 - 32
File Transfer 

Settings
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3rd Party Bluetooth Networking Setup
This information applies to the combo Bluetooth and WLAN module only.

1. Make sure the Bluetooth module is powered on.
2. Double-click the My Bluetooth application on the desktop (or access it from the 

Programs/All Programs menu).
3. Click My Bluetooth Settings (see Figure 7 - 30 on page 7 - 52).

4. Click Network Settings (make sure the Bluetooth module is powered on.
5. Click Enable Bluetooth Network and click OK.
6. A message will appear in the notification area to confirm that the network driver 

has been installed.

Figure 7 - 33
Network Settings
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3rd Party Bluetooth & WLAN Combo Module Configuration
Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module.

To Add a Bluetooth Device
1. Double-click the My Bluetooth application on the desktop (or access it from the 

Programs/All Programs menu).
2. Double-click the device you want to pair with the computer (if no devices appear 

press F5 or click the Refresh button to search for devices).


Bluetooth Module & 

Resuming From Sleep 
Mode

The Bluetooth module’s de-
fault state will be off after re-
suming from the Sleep
power-saving state. Use the
key combination (Fn + F12)
to power on the Bluetooth
module after the computer
resumes from Sleep.

Figure 7 - 34
My Bluetooth 

Devices
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3. You will then be presented with a menu of options to select from.

4. Click the appropriate button to connect to the device.

Figure 7 - 35
Bluetooth Device 

Options
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5. You may need to allow the connection from your device, and you will then need to 
provide a passcode from the device.

6. You can then enter the passcode on the computer and click OK to establish the 
connection.

Figure 7 - 36
Bluetooth Pairing 

Code & Connection 
Established
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Intel Bluetooth Combo Driver Installation
Note this driver is required only for the Intel combo Bluetooth and WLAN module
only.

1. Before installing the driver make sure the Bluetooth module is powered 
on (use Fn + F12 key combination), then insert the Device Drivers & Utili-
ties + User’s Manual disc into the CD/DVD drive. If a Found New Hard-
ware window appears, click Cancel in all windows that appear, and then 
proceed to install the driver as below.

2. Click Option Drivers (button).
3. Click 4.Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Finish.
7. See over for configuration instructions.

Note that, at the time of going to press, Intel® Centrino® Wireless-N 1030 and In-
tel® Centrino Advanced-N 6230 WLAN & Bluetooth V3.0+HS combo modules
use the standard Bluetooth configuration in Windows 7 (see “Intel Bluetooth Com-
bo Driver Installation” on page 7 - 59). Do not use the Bluetooth & WLAN Combo
settings information outlined from page 7 - 52 to page 7 - 58. See also “Intel®
WLAN & Bluetooth V3.0+HS Combo Modules” on page 8 - 17.


High Speed Bluetooth 

Data Transfer

The Combination Wire-
less LAN & V3.0 Blue-
tooth module supports
high speed (V3.0) data
transfer. However to
achieve such transfer
speeds, both devices
must support high
speed data transfer.

To obtain high speed
(V3.0) data transfer
make sure that both the
WLAN and Bluetooth
modules are powered
on.

Check your Bluetooth
compatible device’s doc-
umentation to confirm it
supports high speed data
transfer.
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Standard Bluetooth Configuration in Windows 7

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module. 
2. A Bluetooth icon  will appear in the notification area.
3. You can then do any of the following to access the Bluetooth Devices control

panel.

• Double-click the notification area icon  to access the Bluetooth Devices control panel.

• Click/Right-click the notification area icon  and choose an option from the menu.


Add a Device

Click Start, and click Con-
trol Panel and then click
Devices and Printers
(Hardware and Sound).
Click Add a device to
search for any available
Bluetooth devices.

Bluetooth Module & 
Resuming From Sleep 

Mode

The Bluetooth module’s de-
fault state will be off after
resuming from the Sleep
power-saving state. Use
the key combination (Fn +
F12) to power on the Blue-
tooth module after the com-
puter resumes from Sleep.

Figure 7 - 37
Bluetooth Devices & 

Click Icon Menu

Add a device

Right-Click Notification Area Icon 
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To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.

3. On first connection the computer will provide you with a pairing code to be entered 
onto the device.


Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure 7 - 38
Add a Device
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4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

5. Windows will check to see if any drivers are required to complete the pairing. 
6. Follow any on-screen instructions on the computer if device drivers are required to

be installed.
7. Click Close.

Figure 7 - 39
Pairing Code 

Example

Figure 7 - 40
Pairing Complete & 
Bluetooth Device 

Enabled


Pairing Codes

The example outlined here shows a connection to
a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.
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To Change Settings for the Bluetooth Device
1. Click the notification area icon and select Show Bluetooth Devices.
2. Right-click on the device you want to change and click Properties to:

• Change the name of the device (click Bluetooth, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Click the notification area icon and select Open Settings.
2. Click Options, and make sure that Allow Bluetooth devices to find this 

computer check box (Discovery) has a tick inside it.
3. Make sure that the Alert me when a new Bluetooth device wants to connect 

check box (Connections) has a tick inside it, if you want to be notified when a 
Bluetooth device wants to connect.


Bluetooth Help

To get help on Bluetooth
configuration and set-
tings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box, and
select an item from the re-
turned search results to
get more information.

Figure 7 - 41
Bluetooth Settings - 

Options
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THX TruStudio Pro Audio
Install the THX TruStudio AP to allow you to configure the audio settings to your
requirements for the best performance in games, music and movies. Press the THX
TruStudio Pro Touch Sensor Instant Key  to toggle the THX TruStudio AP
On/Off.

THX TruStudio AP Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 5.Install THX TruStudio AP > Yes.
4. Choose the language you prefer and click Next.
5. Click Yes to accept the license.
6. Click Next.
7. Click Full Installation (button).
8. Click Next > Finish to restart the computer.


THX TruStudio & 

Speaker 
Configuration

Note that THX TruStu-
dio Pro will be dis-
abled when you are
connecting to an exter-
nal display through an
HDMI connection.
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THX TruStudio Pro Activation
On the first run of THX TruStudio Pro you will need to activate the application. 

1. To activate the application you will need to be connected to the internet. 
2. Double-click the THX Activate icon  on the desktop and click the Activate 

button.
3. The program will connect to the internet to verify the activation key.
4. Click Finish to complete the application activation.
5. Restart the computer after the process is complete.

THX TruStudio Pro Application
The application can be run from the shortcut in the Start menu (Start > All Pro-
grams >Creative > THX TruStudio Pro Settings).


THX Audio & HDMI

Note that the THX audio
effects do not apply to
aud io  genera ted
through an HDMI con-
nection.

Figure 7 - 42
THX TruStudio Pro 

Menu

Power On/Off

Collapse/Expand View

Menu
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THX Control Panel
Each control has an On/Off button to allow you to enable/disable the control, and
most controls feature a slider to adjust the levels (the subwoofer may be turned on/
off). 

• Surround: Provides virtual sound channels to control the level of immersion.
• Crystalizer: Enhances audio to make it sound livelier. 
• Speaker: Enhances the bass level of the sound system. 
• Smart Volume: Minimizes sudden volume changes to avoid the need for con-

stant adjustment. 
• Dialog Plus: Enhances dialogue levels for movies etc.

Figure 7 - 43
THX TruStudio Pro 

Controls

Menu
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THX TruStudio Pro & HDMI
1. When you connect an HDMI display to the HDMI-Out port, the THX Tru Studio Pro 

controls will be disabled.
2. A warning box will pop-up and will prompt “Do you want to select another audio 

device now?”.
3. Click No to continue using the HDMI audio output from your external display (do 

not attempt to select another audio device when connected to the external HDMI 
display).

Figure 7 - 44
THX TruStudio Pro 

HDMI Display 
Warning

Menu
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Chapter 8: Troubleshooting

Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 8 - 1



Troubleshooting

8

Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power Indicators (see “LED Indicators” on page 1 - 7) 
to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Configuring the Power Buttons” on page 3 - 8), the Fn + F4 key combi-
nation, or power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness (see Table 1 - 3, on page 1 - 11).

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the 
disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
8 - 2 Basic Hints and Tips



Troubleshooting

8

Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Boot password for the SCU (see “Security Menu” on page 5 - 11).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief 
notes).


Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
Backup and General Maintenance 8 - 3
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
8 - 4 Viruses
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).

• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.
Upgrading and Adding New Hardware/Software 8 - 5
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• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices 
and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
8 - 6 Upgrading and Adding New Hardware/Software
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Problems & Possible Solutions

Problem Possible Cause - Solution

You turned the power on
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is present and
seated properly (the design of the battery only allows it to go in one way). Make sure there’s
nothing interfering with the battery contacts.

The Battery LED power
indicator , is blinking
orange.

Low Battery. Plug in the AC power source. If the computer doesn’t start up immediately, turn it off
then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see “Power
Plans” on page 3 - 4) check its settings. You may also be using an ExpressCard device/USB
device/external device that is drawing a lot of power.

You are attempting to run an SLI configuration on battery power. Due to the high power and
system demands created by enabling SLI Configuration, you should not enable SLI
configuration if your computer is powered by battery only.

Actual battery operating
time is shorter than
expected.

The battery has not been fully discharged before being recharged. Make sure the battery is fully
discharged and recharge it completely before reusing (see “Battery Information” on page 3 -
10).

Check the settings of any active power plan (see “Power Plans” on page 3 - 4).

A peripheral device/USB device is consuming a lot of power. Turn off/remove the unused device
to save power.
Problems & Possible Solutions 8 - 7
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The computer feels too
hot.

Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the
computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 16). Make sure
you’re using the correct adapter. 

Make sure that your notebook is completely powered off before putting it into a travel bag (or any
such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan
intakes to be blocked.

Nothing appears on
screen.

The system is in a power saving mode. Toggle the Fn + F4 (see “Configuring the Power
Buttons” on page 3 - 8).
\

The screen controls need to be adjusted. Toggle the screen control Fn + F8/F9 key
combinations. If you’re connected to an external monitor, make sure it’s plugged in and turned on.
You should also check the monitor’s own brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key Fn + F7 combination. If
an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on
the external monitor I
have plugged in and
powered on.

You haven’t installed the video driver and configured it appropriately from the Control Panel. See
“NVIDIA Video Driver Controls” on page B - 1 for instructions on installing and configuring the
video driver.

Problem Possible Cause - Solution
8 - 8 Problems & Possible Solutions
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You forget the boot
password.

If you forget the password, you may have to discharge the battery of the CMOS. Contact your
service representative for help.

The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume control in the Volume Control Panel in the
Windows taskbar, use the key combination Fn + F5 and F6 or move your finger slowly along the
volume control slider to adjust the system volume (see “Audio Features” on page 2 - 9/“Touch
Sensor Instant Keys” on page 1 - 9) to adjust.

The CD/DVD cannot be
read.

The compact disc is dirty. Clean it with a cleaner kit.

The Optical Disk Drive
tray will not open when
there is a disc in the tray.

The disc is not correctly placed in the tray. Gently try to remove the disc using the eject hole (see
“Loading Discs” on page 2 - 3).

The DVD regional
codes can no longer be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5.

Problem Possible Cause - Solution


Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
Problems & Possible Solutions 8 - 9
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The TouchPad doesn’t
work.

The Touchpad has been disabled. Press the Touchpad toggle (Fn + F1) key combination (make
sure you have installed the Touchpad driver.

I am sliding my finger up
and down on the right
side of the TouchPad to
scroll a Window and the
TouchPad does not
respond.

There are different TouchPad versions available on this computer, and this version requires
tapping/holding to scroll. Either tap repeatedly, or hold the finger down, at the top or bottom right
of the touchpad (depending on the scrolling direction required) to scroll the window.

The system freezes or
the screen goes dark.

The system’s power saving features have timed-out. Use the AC/DC adapter, press a key on the
keyboard, or press the sleep (Fn + F4) key combination, or press the power button if no LEDs are
lit.

The system never goes
into a power saving
mode.

Power Options features are not enabled. Go to the Windows Power Options menu and enable
the features you prefer (see “Power-Saving States” on page 3 - 6). Make sure you have
enabled Hibernate mode from the control panel.

The Wireless LAN/
Bluetooth/PC Camera
modules cannot be
detected.

The modules are off. Check the appropriate Touch Sensor indicator to see if the modules are on
or off (see “Touch Sensor Instant Keys” on page 1 - 9). If the LED indicator is not illuminated,
then press the appropriate touch sensor instant key/function key combination in order to enable
the modules.

The Wireless LAN/
Bluetooth/PC Camera
modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have installed the driver
for the appropriate module (see the instructions in Chapter 7 “Modules” for the appropriate
module).

Problem Possible Cause - Solution
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When a DVD is played in
Windows Media Player/
Media Center, the audio
track in other languages
(commentaries etc.) is
not clear if connected to
the S/PDIF-Out Jack.

This is an issue with Windows Media Player/Media Center and audio output through the S/PDIF-
Out Jack. We recommend that you use the Power DVD application to play DVDs.

Nothing appears on the
screen when the PC
Camera software is run.

You have selected an external display as the default display device. The PC Camera application
software needs to be run while the default notebook LCD is the selected display device. 
After a camera picture is obtained on the default notebook LCD, you may then use the Fn + F7 to
toggle through the display modes (give the screen time to refresh).
If you have selected an external display as your display device do not run the PC Camera
software application until you have switched back to the notebook LCD.

A file cannot be copied
to/from a connected
Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is supported in one
direction only (simultaneous data transfer is not supported). If you are copying a file from
your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth
enabled device to your computer until the file transfer process from the computer has been
completed

The Bluetooth module is
off after resuming from
Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state.
Use the key combination (Fn + F12) to power on the Bluetooth module after the computer
resumes from Sleep.

Problem Possible Cause - Solution
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No sound can be heard
through an HDMI
connected display
device.

You have not configured the HDMI audio output. See “HDMI Audio Configuration” on page B -
18.

You have a RAID
enabled and the system
will not boot to Windows.

You may need to recover the RAID volumes.

1. As the computer starts up press Ctrl + i to enter RAID configuration menu
2. If the RAID volume’s Physical disks are marked in red, then press 4.Recovery 

Volume Options.
3. If you cannot access 4.Recovery Volume Options (i.e. it is grayed out) then press 

5.Acceleration Options.
4. Press Enter and return to the main menu, then press 4.Recovery Volume 

Options.
5. Follow the on screen instructions to recover the Physical disks.
6. If only one of the physical disks now appears green, then press 6.Exit to save the 

changes and exit and boot to Windows.
7. When Windows is loaded run the Intel® Matrix Storage Console from the Intel® 

Matrix Storage Manager in the Programs/All Programs menu.
8. Click View > Advanced Mode.
9. Right-click on the RAID volume and select either Verify Volume Data or Verify 

and Repair Volume Data.
10. The verification or verification and repair process will run and display progress.
11. A dialog box will display the final status of the verification or verification and repair 

status.

Problem Possible Cause - Solution
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The computer is off (or in
Sleep Mode) but
powered by the AC/DC
adapter plugged in to a
working outlet, or by
battery with a capacity
above 20%. I have
plugged a device into
the powered USB port
in order to charge it, but
the device is not
charging.

The port is not powered on. Toggle power to the port using the Fn + power button combination.

This function may not work with certain external USB compliant devices (check your device’s doc-
umentation). If this is the case, power the computer on and connect the external USB device
in order to charge it.

Problem Possible Cause - Solution
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Bluetooth Connection Problems
If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and
headsets) it maybe necessary to download and install the Windows Mobile Device Center software (for Win-
dows Vista and Windows 7). Go to the Microsoft website and search for the Microsoft Windows Device Center
Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver. 

1. Install the Microsoft Windows Device Center Driver as appropriate for your operating system.
2. Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
3. Make sure the Bluetooth device is powered on.
4. Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and 

Printers).
5. Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have 

connected, or tried to connect to, a Bluetooth device previously).

Figure 8 - 1 - Device Manager


Bluetooth Peripheral Devices

You will need to repeat the procedure
listed here for all Bluetooth Peripher-
al Devices listed under Other Devices
i.e. until there are no more Bluetooth
Peripheral Devices listed under this
menu heading.
8 - 14 Bluetooth Connection Problems
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6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.
7. Click Browse my computer for driver software.
8. Click Let Me pick from a list of device drivers on my computer.

Figure 8 - 2 - Browse my computer.../Let me pick from...

9. Select Bluetooth Radios from the list.

Figure 8 - 3 - Select Bluetooth Radios
Bluetooth Connection Problems 8 - 15
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10. A list of drivers will appear with Manufacturer on one side and Model in the other. 
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not 

choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for 
Microsoft Corporation to appear in the list). 

12. Select Windows Mobile-based device support from the Model list.

Figure 8 - 4 - Select Device Driver

13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.

Make sure you select
Microsoft Corporation
8 - 16 Bluetooth Connection Problems
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15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth 
Radios.

16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

Figure 8 - 5 - Device Manager - Bluetooth Radio
Bluetooth Connection Problems 8 - 17
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Intel® Centrino Advanced WLAN & Bluetooth V3.0+HS Combo Modules
Note that, at the time of going to press, Intel® Centrino® Advanced-N 6230 or Intel® Wireless-N 1030
WLAN & Bluetooth V3.0+HS combo modules use the standard Bluetooth configuration in Windows 7 (see
“Standard Bluetooth Configuration in Windows 7” on page 7 - 38). Do not use the Bluetooth & WLAN Com-
bo settings information outlined from page 7 - 30 to page 7 - 36.

Driver Release Update
Note also that, at the time of going to press, this module does not support high speed Bluetooth (V3.0) data trans-
fer. Intel have scheduled a driver release to allow this module to support high speed data transfer, so please check
with Intel or your service center for details.
8 - 18 Intel® Centrino Advanced WLAN & Bluetooth V3.0+HS Combo Modules
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Installing Windows 7 (pre Service Pack 1) for RAID Systems 
with Advanced Format Disks
The following information is only applicable under the following conditions:

• You are configuring your SATA hard disks in a RAID.
• You are using Advanced Format hard disks that have a 4KB physical sector size.
• You are using a Windows 7 version that DOES NOT include Service Pack 1 on the DVD disc.

Windows 7 versions pre Service Pack 1 (i.e. those that do not include the installation of Service Pack 1 from
the actual DVD disc) require a driver to support Advanced Format hard disks with a 4KB physical sector size
when used in a RAID. 

This driver is included on the Device Drivers & Utilities + User’s Manual disc but you will need to go to an
operable computer and copy the driver to a USB Flash drive, external USB hard disk or external floppy disk
drive and floppy diskette, as it is required as part of the Windows 7 system installation process.

1. Go to the operable computer and insert a USB Flash drive, external USB hard disk or external USB floppy disk 
drive and floppy diskette.

2. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive of the operable computer.
3. Copy the f6flpy-x** folder from the location below (D: denotes your DVD drive) on the Device Drivers &

Utilities + User’s Manual disc to the USB Flash drive, external USB hard disk or floppy diskette.

• For Windows 7 32bit = D:\Option\06RAID\f6flpy-x86
• For Windows 7 64bit = D:\Option\06RAID\f6flpy-x64
Installing Windows 7 (pre Service Pack 1) for RAID Systems with Advanced Format
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4. Press a key at system startup to begin installing Windows from your Microsoft Windows 7 disc (make sure 
the DVD device is set at the top of the Boot Sequence in the BIOS - see “Boot Sequence (Boot Menu)” on 
page 5 - 14). 

5. Click Install Now.
6. Make sure your USB Flash drive, external USB hard disk or external USB floppy disk drive and floppy diskette 

is attached to one of the USB ports on the computer.
7. Click “I accept the license terms” tickbox and click Next.
8. Click Custom (advanced).
9. Click to select Load Driver when the “Where do you want to install Windows?” screen appears.
10. Click Browse and browse to the location you copied the files to on your USB Flash drive, external USB hard 

disk or external USB floppy disk drive and floppy diskette (X: denotes your USB Flash drive, external USB hard 
disk or external USB floppy disk drive):

• Windows 7 32bit - X:\f6flpy-x86\iaStor.inf
• Windows 7 64bit - X:\f6flpy-x64\iaStor.inf

11. Click Next (or format the drive to your preferences).
12. Follow the on-screen instructions to install the Windows 7 operating system.
13. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual disc as per Table 4 - 1, on 

page 4 - 3 (make sure you install the Intel Rapid Storage Technology driver - see “IRST Driver Installation” 
on page 7 - 8).
8 - 20 Installing Windows 7 (pre Service Pack 1) for RAID Systems with Advanced Format 
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Partitioning HDDs with a Combined Capacity Exceeding 2 TB
Hard Disk Drives with a combined capacity exceeding 2 Terabytes cannot be partitioned under Windows 7 in-
stallation. The system must be set to start up from the DVD drive under Unified Extensible Firmware Interface
(UEFI) at Boot Options (or in the BIOS) and a USB mouse must be attached as the TouchPad will not func-
tion under UEFI boot. Follow the procedure below if you are setting up hard disks with a combined capacity
exceeding 2 Terabytes:

1. Start the computer up with the Windows 7 (with Service Pack 1) DVD inserted in the optical device drive, and 
a USB mouse attached to one of the USB ports.

2. As the computer starts up press F7 to enter Boot Options.
3. Choose the optical device drive under the UEFI (not the standard ODD).

Figure 8 - 6 - Boot Options
Partitioning HDDs with a Combined Capacity Exceeding 2 TB 8 - 21
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4. Press Enter to start the computer up and proceed with the on-screen instructions to install Windows 7 (SP1).
5. Make sure you use the attached USB mouse when selecting options, as the TouchPad will not function under 

UEFI boot.
6. Create partitions as required and install Windows 7 (SP1) as per the on-screen instructions.
7. After installing Windows 7 (SP1) you will be required to restart the computer (make sure you are still using the 

attached USB mouse).
8. If you have input a password you may need to use the On-Screen Keyboard to enter your password; click the 

Ease of access  icon at the bottom left of the screen and click to put a check in the "Type without the 
keyboard (On-Screen keyboard)" checkbox and click OK/Apply.

9. After Windows starts up you should then install a driver to support the TouchPad and keyboard from the 
Device Drivers & Utilities + User's Manual disc.

10. Eject the Windows 7 (SP1) disc and insert the Device Drivers & Utilities + User's Manual disc into the optical 
device drive.

11. Browse to the executable file in the following location:

• Driver DVD\ Option\07PS2_Filter\autorun.exe

12. Install the driver as instructed to support TouchPad and keyboard input.
13. Install the remaining drivers as instructed in Chapter 4 "Drivers & Utilities" (make sure the divers are installed 

in the order indicated in Table 4 - 1, on page 4 - 3).
8 - 22 Partitioning HDDs with a Combined Capacity Exceeding 2 TB
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Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the ports & jacks which allow your computer to commu-
nicate with external devices, connect to the internet etc.
Interface (Ports & Jacks) A - 1
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Ports and Jacks

Item Description

Card Reader The card reader allows you to use the following digital storage cards:

MMC (MultiMedia Card) RS MMC (requires PC adapter)
SD (Secure Digital) Mini SD (requires PC adapter)
MS (Memory Stick) MS Duo (requires PC adapter)
MS (Memory Stick Pro)

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

DVI-Out Port The DVI-Out (Digital Visual Interface) Port is a video connector interface. This allows you to
connect an external monitor, TV or Flat Panel Display etc. as a display device (see “Configuring
an External Display (NVIDIA)” on page B - 7) by means of a DVI cable. If you are using an
older type of monitor you will need to use a converter to convert the signal from DVI to VGA.

e-SATA/USB Port This is a combined e-SATA (external Serial Advanced Technology Attachment)/ USB 2.0
compatible port.

Plug external Serial ATA hard drives into this e-SATA (external Serial Advanced Technology
Attachment) port. See “USB 2.0/1.1 Ports*” on page A - 5 for USB port information.

e-SATA /
A - 2 Interface (Ports & Jacks)
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HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) port is an audio/video connector
interface for transmitting uncompressed digital streams. This allows you to connect an external
monitor, TV or Flat Panel Display etc. as a display device (see “Configuring an External
Display (NVIDIA)” on page B - 7) by means of a HDMI cable. Note that HDMI carries both
audio and video signals (see “HDMI Audio Configuration” on page B - 18).

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume
to a reduced level before connecting to this jack.

Line-In Jack The Line-In jack allows you to play audio sources through the computer’s speakers. Note that
audio input through Line-in will default to the mute setting. To set up your audio sources to play
through the Line-in jack go to the Sound  control panel and make sure the Mute box is not
ticked.

Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

Item Description

HDMI
Interface (Ports & Jacks) A - 3
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Mini-IEEE 1394 Port This allows high-speed connection to various peripheral devices, e.g. external disk drives and
digital cameras (see note below).

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

Item Description


IEEE 1394

The Mini-IEEE 1394 ports only support SELF POWERED IEEE 1394 devices.
A - 4 Interface (Ports & Jacks)
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USB 2.0/1.1 Ports*

USB 3.0 Port

These USB (Universal Serial Bus) 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are
for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals
such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be
plugged into the computer, and unplugged from the computer, without the need to turn the
system off (if the power rating of your USB device is 500mA or above, make sure you use the
power supply which comes with the device).

This model has two USB 3.0 ports on the left side of the computer which are denoted by their blue
color. USB 3.0 will transfer data much faster than USB 2.0, and is backwards-compatible with
USB 2.0. The USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7).

*Note: The powered USB 2.0 port (see “Left View” on page 1 - 14) may be toggled on /off by
means of the Fn + Power Button key combination. When the powered USB port is on it will supply
power when the system is off but still powered by the AC/DC adapter plugged into a working outlet,
or powered by the battery with a capacity level above 20% (this may not work with certain devices
- see page 8 - 13).

Item Description

3.0
Interface (Ports & Jacks) A - 5
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Appendix B: NVIDIA Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 18.

NVIDIA Video Driver Installation
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

1. Insert the Device Drivers & Utilities + User’s Manual disc and click Install 
Drivers (button).

2. Click 2.Install nVIDIA VGA Driver > Yes.
3. Click AGREE AND CONTINUE (button) to accept the terms of the 

license agreement.
4. Click Next.
5. Click the RESTART NOW button to restart the computer.

After Video (VGA) driver has been installed, and the system restarted, the OS will
automatically run the "Winsat.exe" to rate the performance. Allow time for this pro-
cess to finish and do not restart during this process (if you have restarted the system
see “Windows Update” on page 4 - 9).


Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your service center for
the latest details on vid-
eo cards supported (see
“Video Adapter Op-
tions” on page C - 2, or
contact your service
center for details).
NVIDIA Video Driver Installation B - 1
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NVIDIA Control Panel
More advanced video configuration options are provided in the NVIDIA Control
Panel tab.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the

menu if you are in Control Panel Home).


NVIDIA Control 

Panel 

To access the Ge-
Force..... control panel
from the desktop; right-
click the desktop, then
click NVIDIA Control
Panel.

Figure B - 1
NVIDIA GeForce..... 

Control Panel
B - 2 NVIDIA Control Panel
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The NVIDIA Control Panel provides additional video configuration controls and
tools which allow quick access to features such as display configuration, 3D Settings
and Help menus etc.


Navigating the 
Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.
Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

Figure B - 2
NVIDIA Control 

Panels
NVIDIA Control Panel B - 3
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The Help menus provide index and search features, and direct links to the NVIDIA
website etc.

Figure B - 3
Help Menu
B - 4 NVIDIA Control Panel
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Display Devices
Note that you can use a DVI cable connected to the DVI-Out port, or an HDMI
(High-Definition Multimedia Interface) cable connected to the HDMI-Out port to
connect an external display (if you are using an older type of monitor you can use a
converter to convert the signal from DVI to VGA). See your display device manual
to see which formats are supported.

1. The built-in LCD.
2. An external display connected to the DVI-Out Port.
3. An external display/TV (if the TV supports an HDMI connection) connected to the

HDMI-Out Port.


Display Devices

Besides the built-in LCD,
you can also use an exter-
nal monitor/flat panel dis-
play as your display device.
The display options are:

• The built-in LCD.
• An external display con-

nected to the DVI-Out 
port.

• An external display con-
nected to the HDMI-Out 
port.

Note that HDMI supports
video and audio signals.

Note that THX TruStudio
Pro will be disabled when
you are connecting to an
external display through an
HDMI connection.

DO NOT use the Fn + F7
key combination to toggle
through display options
when SLI is enabled.l
Display Devices B - 5
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Display Modes
Single Display Mode
Only one of your displays is used.

Duplicate Displays
Duplicate simply shows an exact copy of the Primary display desktop on the other
display(s). This mode will drive multiple displays with the same content.

Extend Desktop
Extend Desktop treats both connected displays as separate devices, and they act as
a virtual desktop resulting in a large workspace. When enabled, you can drag any
icons or windows across to the other display desktop. It is therefore possible to have
one program visible in one of the displays, and a different program visible in the oth-
er display.


SLI Configuration & 

Multiple Displays

Note that if SLI configu-
ration is enabled only a
Single display may be
used as the display de-
vice.

DO NOT use the Fn +
F7 key combination to
toggle through display
options when SLI is en-
abled. SLI supports only
a Single display, and at-
tempting to configure
dual displays may cause
an error. Use the NVID-
IA control panel to select
the display to be used.
B - 6 Display Modes
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Configuring an External Display (NVIDIA)
You can use the NVIDIA control panel to configure any attached displays.

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see page B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up

multiple displays.
4. Any attached display will appear under “1.Select the displays you want to use.”

5. Click the tickbox alongside any display you wish to use.
6. Click Apply > Yes to save any changes made (the Apply button will appear in the

bottom right of the control panel when changes have been made).


Display Not Shown

If the attached display
does not appear in the
“1.Select the displays
you want to use.” win-
dow, click “My Display
is not shown...” and
then click the appropri-
ate button to force de-
tection of the missing
display.

Figure B - 4
Set Up Multiple 

Displays


HDMI Audio Setup

See “HDMI Audio Con-
figuration” on page 2 -
8 for instructions on con-
figuring audio for HDMI
display devices. 

Set up your external dis-
play (TV or LCD) for
HDMI input (see your dis-
play device manual).
Configuring an External Display (NVIDIA) B - 7
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Duplicating the Displays
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see page B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up

multiple displays.
4. Any attached display will appear under “1.Select the displays you want to use.”
5. Click the tickbox alongside any display you wish to use.
6. Right-click one of the display icons and click “Duplicate displays....” (select which

is to be the primary display) to duplicate the desktop on both displays.

7. Click Apply > Yes to save any changes.

Figure B - 5
Duplicate 
Displays

Select Apply > Yes 

Right-click to select Duplicate displays
 and which is to be used as the primary clone   

to save changes 
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Extending the Display
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see page B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up

multiple displays.
4. Click to select a primary display under “1.Select the displays you want to use.”
5. Right-click one of the display icons and click “Extend desktop on this display....”

to extend the desktop across both displays.

6. Click Apply > Yes to save any changes.


Changing the 

Primary Display on 
Extended Displays

If you want to switch the
primary display if the
displays are extended
then right-click the sec-
ondary display icon. Se-
lect “Make this the
Windows main dis-
play”. Click Apply >
Yes to save the change
(see over).

Figure B - 6
Extend the Display

Click to select the display to be used as the primary display

Right-click Extend desktop on this display 

Select Apply > Yes 
to save changes 
Configuring an External Display (NVIDIA) B - 9
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Changing the Primary Display on Extended Displays
1. If you want to switch the primary display if the displays are extended then right-

click the secondary display icon.
2. Select Make this the Windows main display.
3. Click Apply > Yes to save the change.

Figure B - 7
Switch Primary 

Display Select Apply > Yes 

Right-click to select the secondary display
and select Make this the Windows main display.

to save changes 
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Attaching Other Displays (Win 7)
Configuring an External Display in Windows 7
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to the Screen resolution control panel.
3. Click the Detect button.
4. The computer will then detect any attached displays.


Function Key 
Combination

You can use the Fn + F7
key combination to toggle
through the display op-
tions:

• Notebook Only
• External Display Only
• Notebook + External 

Display

Make sure you give the
displays enough time to
refresh.

DO NOT use the Fn + F7
key combination to toggle
through display options
when SLI is enabled.

Figure B - 8
Screen Resolution 

Multiple Displays

(Win 7)
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5. You can configure the displays from the Multiple Displays menu.

• Duplicate these displays - Shows an exact copy of the main display desktop on 
the other display(s)

• Extend these displays - Treats both connected displays as separate devices
• Show desktop only on 1/2 - Only one of your displays is used.

Figure B - 9 

Screen Resolution 

Multiple Display 

Options

(Win 7)
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Using the Windows Logo Key  + P Key Combination to Switch Displays
You can also use the  + P key combination to quickly change display configura-
tion and modes (this is particularly useful when attaching a projector) in Windows 7.

1. Attach your external display to the external monitor port and turn it on.
2. Press the  + P key combination.
3. An on-screen menu will pop up.
4. Use the cursor keys (or  + P) to select the appropriate configuration from the

menu, and press Enter to confirm the selection.

Figure B - 10
 + P Display 

Configuration 

Selection

(Win 7)
Attaching Other Displays (Win 7) B - 13
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SLI Multi GPU Configuration
This computer features an NVIDIA Scalable Link Interface (SLI) that improves
graphic quality and performance by combining dual NVIDIA GPUs (two video
cards are required) in a single system. To enable/disable SLI Configuration:

1. Go to NVIDIA Control Panel (see page B - 2).
2. Click “+” next to 3D Settings if its sub-items are not shown and then click Set SLI 

and PhysX configuration.

3. Click “Maximize 3D Performance” under “SLI configuration:”.
4. Click to select “PhysX settings; Auto-select (recommended) is the default setting.
5. Click Apply and Restart Now to restart the computer (see over).


Video Card 

Options

Note that card types,
specifications and driv-
ers are subject to con-
tinual updates and
changes. Check with
your service center for
the latest details on
video cards supported.
Note that not all video
card options for this
computer model series
support SLI configura-
tion (see “Video
Adapter Options” on
page D - 2, or contact
your service center
for details).

Figure B - 11
Set SLI 

Configuration

Select Restart Now 
to restart the computer 
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SLI Multi GPU Configuration & Battery Power
Note that due to the high power and system demands created by enabling SLI Con-
figuration, you should not enable SLI configuration if your computer is powered
by battery only. If you attempt to run an SLI configuration when the computer is
powered by the battery only, then system problems may occur.

• If the computer is currently powered by battery only do not enable SLI config-
uration. 

• If you have currently enabled SLI configuration, and the computer is powered 
by the AC/DC adapter, do not switch to battery power only (or go to the 
NVIDIA Control Panel and disable SLI configuration before switching to bat-
tery power only).


SLI Configuration & 

Multiple Displays

Note that if SLI configu-
ration is enabled only a
Single display may be
used as the display de-
vice.

DO NOT use the Fn +
F7 key combination to
toggle through display
options when SLI is en-
abled. SLI supports only
a Single display, and at-
tempting to configure
dual displays may cause
an error. Use the NVID-
IA control panel to select
the display to be used.
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Manage 3D Settings
You can configure the 3D global settings (to be applied to all application programs)
or make specific adjustments for installed program settings.

1. Go to NVIDIA Control Panel (see page B - 2).
2. Click Manage 3D Settings and select either Global Settings or Program Settings.
3. Click the Setting menu items to select any global options required, or select a

program to customize from the drop-down menu (click Add to add any program
that does not appear in the menu).

4. Click Apply to save the settings.

Figure B - 12
Manage 3D 

Settings
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Adjust Video Settings
You can adjust video color and image settings from the Video sub-menus.

1. Go to NVIDIA Control Panel (see page B - 2).
2. Click “+” next to Video if its sub-items are not shown and then click either Adjust

video color settings or Adjust video image settings.
3. Make any adjustments required for any display and click Apply to save the

settings.

Figure B - 13
Adjust Video Color 

Settings
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HDMI Audio Configuration
As HDMI (High-Definition Multimedia Interface) carries both audio and video sig-
nals you can configure the audio output from the NVIDIA control panel and Sound
control panel. The settings will depend upon the external HDMI display you have
connected to.

When you connect a display to the HDMI-Out Port then the Set up digital audio
item will appear under Display. Click “Change Windows Sound Settings” (button)
to access the Sound control panel. 

Figure B - 14
Set up Digital Audio
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Audio Setup for HDMI
In some cases it will be necessary to go to the Sound control panel and manually con-
figure the HDMI audio output.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Playback (tab)
4. The playback device will be selected.
5. You may need to select the audio device and click Set Default (button).
6. Double-click the device to access the control panel tabs.

Figure B - 15
Sound Playback 

Options
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7. Adjust the HDMI settings from the control panel tabs.
8. Click OK to close the Sound  control panel.

Figure B - 16
HDMI Device 

Properties
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HDMI Notes
• Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-

ing to play audio/video sources through the device.

• Under certain conditions, if the HDMI cable is disconnected, the default audio 
playback device will not revert to speakers until the computer is restarted (if you 
do not wish to restart the computer then go to the Sound control panel and select 
Speakers as the default audio playback device).

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Configuring an

External Display (NVIDIA)” on page B - 7.
3. Set up your external display (TV or LCD) for HDMI input (see your display device

manual).
4. You can now play video/audio sources through your external display.

THX TruStudio Pro & HDMI
1. When you connect an HDMI display to the HDMI-Out port, the THX TruStudio Pro 

controls will be disabled. 
2. A warning box will pop-up and will prompt “Do you want to select another audio 

device now?”.
3. Click No to continue using the HDMI audio output from your external display (do 

not attempt to select another audio device when connected to the external HDMI 
display).


 Other Applications

If you are using a third
party application to play
DVDs etc. you will need
to consult the applica-
tion’s documentation to
see the appropriate au-
dio configuration (the
application must support
digital to analog transla-
tion).
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NVIDIA Video Driver Controls

B

HDCP Status
If your external display is HDCP (High Bandwith Digital Content protection) com-
patible then the NVIDIA control panel will display the HDCP system status.

Figure B - 17
HDCP Status
B - 22 HDMI Audio Configuration
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Appendix C: Specifications


Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.
Specifications C - 1
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Processor

Note all processor packages are 
rPGA988B

Intel® Core i7-2920XM (2.5GHz) - 
Extreme Quad-Core Mobile Processor 
8M L3 Cache, 32nm (32 Nanometer), 
DDR3-1600MHz, TDP 55W

Intel® Core i7-2820QM (2.3GHz)
Quad-Core Mobile Processor
8M L3 Cache, 32nm (32 Nanometer), 
DDR3-1600MHz, TDP 45W

Intel® Core i7-2720QM (2.2GHz)
Quad-Core Mobile Processor
6M L3 Cache, 32nm (32 Nanometer), 
DDR3-1600MHz, TDP 45W

Intel® Core i7-2630QM (2.0GHz)
Quad-Core Mobile Processor
6M L3 Cache, 32nm (32 Nanometer), 
DDR3-1600MHz, TDP 45W

Core Logic

Intel® HM67 Chipset

Display

18.4" (46.74cm) FHD (1920 * 1080) 16:9 
TFT LCD (Embedded Light Sensor 
Controls Panel Automatically)

Memory

Dual Channel DDRIII (DDR3)

*Three 204 Pin SO-DIMM Sockets 
Supporting DDRIII (DDR3) 1333/1600** 
MHz Memory Modules

*Memory Expandable up to 12GB
Compatible with 2GB or 4GB Modules

**Note: 1600 MHz Memory Modules are 
only supported by Quad-Core CPUs to a 
maximum of two SO-DIMMs.

Video Adapter Options

nVIDIA® GeForce GTX 560M PCIe 
Video Card
1.5GB GDDR5 Video RAM On Board
Supports Microsoft DirectX® 11.0
Supports HDCP
Supports DVI Dual Link
Supports HDMI 1.4a
NVIDIA PhysX™
GeForce CUDA™ Technology
Supports nVIDIA® SLI Technology

BIOS

One 32Mb SPI Flash ROM
AMI BIOS

Storage

Up to three (Factory Option) 
Changeable 2.5" 9.5 mm (h) SATA 
(Serial) Hard Disk Drives supporting 
RAID level 0/1/5
Note 1st & 2nd HDDs are in SATA III 
interface

One 12.7 mm Super Multi/Blu-Ray 
Combo/Blu-Ray Writer SATA Optical 
Device Drive (Factory Option)
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Audio

High Definition Audio
S/PDIF Digital Output
Built-In Microphone
5.1 Channel Speakers (with Sub woofer) 
THX Surround Sound
7.1CH Audio output supported by 
headphone, microphone, S/PDIF & Line-
In Jack

Keyboard & Pointing Device

Full Size Winkey Isolated Keyboard with 
Numeric Keypad

Built-In TouchPad (with Multi Gesture 
Functionality)

Eight Touch Sensor Instant Keys (Light 
Sensor Control, CCD, Bluetooth, WLAN, 
Internet, Silent Mode, Sound Effect, 
Mute)

Eight Gaming Keys G1 ~ G8
W/A/S/D Game Key Marking

Card Reader

Embedded Multi-In-1 Card Reader 
- MMC / RSMMC
- SD / Mini SD / SDHC / SDXC
- MS / MS Pro / MS Duo

Note: Some of these cards require PC 
adapters that are usually supplied with 
the cards.

Slots

One ExpressCard™/34/54 Slot

One Mini Card Slot for WLAN or WLAN & 
Bluetooth Combo Half Mini-Card Module 
with PCIe & USB Interface

Interface

Four USB 2.0 Ports
(Note: One USB2.0 port on the left side 
can supply power when the system is off 
but still powered by the AC/DC adapter 
plugged into a working outlet, or powered 
by the battery with a capacity level above 
20% - see “USB 3.0 Ports & Powered 
USB 2.0 Port” on page 1 - 14)
Two USB 3.0 Ports
One eSATA Port (SATA Interface, USB 
2.0 Combo)
One Mini-IEEE1394a Port
One DVI-Out Port
One HDMI-Out (High-Definition 
Multimedia Interface) Port (with HDCP 
Support)
One Headphone/Speaker-Out Jack
One Microphone-In Jack
One S/PDIF Out Jack
One Line-In Jack
One RJ-45 LAN Jack
One DC-In Jack
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Communication

Built-In 10/100/100 Base-TX Ethernet LAN

Intel® Centrino® Ultimate-N 6300 3*3
(802.11 a/g/n) Half Mini-Card PCIe WLAN
Module (Factory Option)

Intel® Centrino® Advanced-N 6230 2*2
(802.11 a/g/n) Half Mini-Card PCIe WLAN +
Bluetooth V3.0+HS Combo Module (Facto-
ry Option)

Intel® Centrino® Wireless-N 1030 1*2
(802.11 b/g/n) Half Mini-Card PCIe WLAN +
Bluetooth V3.0+HS Combo Module (Facto-
ry Option)

Bluetooth 2.1 + EDR (Enhanced Data 
Rate) Module (Factory Option)

Combo WLAN (802.11b/g/n) and 
Bluetooth v3.0 Half Mini-Card Module 
(Factory Option)

2.0M Pixel PC Video Camera Module 

Security

Security (Kensington® Type) Lock Slot
BIOS Password
Fingerprint Reader Module (Factory 
Option)

Operating System

Windows® 7 with Service Pack 1

Power Management

Supports Wake on LAN
Supports Wake on USB

Power

Full Range AC/DC Adapter – AC in 100 - 
240V, 50 - 60Hz DC Output 19V, 11.57A 
(220 Watts)
Removable 8 Cell Smart Lithium-Ion 
89.21WH Battery Pack

Environmental Spec

Temperature 
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Physical Dimensions & Weight

439mm (w) * 299mm (d) * 44mm - 65mm (h)
5.6kg with Battery and ODD
C - 4 Specifications
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